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2017









ABSTRAKT

Cílem této diplomové práce je návrh a vývoj systému pro m¥°ení a kontrolu kvality

vytla£ovaných pro�l·, snímaných pomocí digitálního fotoaparátu. Teoretická £ást této

práce se zabývá problematikou digitalizace a popisem obrazových deformací, v£etn¥

moºností, jak je eliminovat. V praktické £ásti je popsán postup implementace korek£-

ních algoritm· s vyuºitím knihovny pro po£íta£ové vid¥ní OpenCV. Na záv¥r jsou

uvedeny výsledky testování vytvo°eného nástroje na reálných pro�lech.

Klí£ová slova: digitalizace, OpenCV, vytla£ování pro�l·, digitální fotoaparát, kontrola

kvality

ABSTRACT

The aim of this master's thesis is to design and develop a system for measuring and

quality control of extruded pro�les captured by a digital camera. The theoretical part

of this thesis deals with the problems of digitization, explains the image distortions

and ways how to elminate them. The practical part describes how to implement the

correction algorithms using the OpenCV computer vision library. At the end, there are

listed the test results of the created tool on the real pro�les.

Keywords: digitization, OpenCV, pro�le extrusion, digital camera, quality control
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ÚVOD

Vytla£ování je v dne²ní dob¥ jeden z nejroz²í°en¥j²ích a nejd·leºit¥j²ích zp·sob· výroby.

Vytla£ovat znamená p·sobit na materiál silou a tla£it jej proti vytvarovanému otvoru.

P°i pr·chodu otvorem získá materiál podobný tvar, jako má otvor. Vytla£ováním se

zpracovává velké mnoºství r·znorodých materiál·, jako je guma, kov, hlína p°i výrob¥

keramiky, nebo nap°íklad t¥sto p°i výrob¥ nudlí.

Samostatnou kapitolou je vytla£ování plast·, které je z hlediska zpracovávaného

mnoºství materiálu nej£ast¥ji pouºívanou metodou p°i výrob¥ plastových výrobk·.

Vyuºívá se pro výrobu ²irokého spektra produkt·. Od polotovar·, jako jsou okenní

rámy, okapy, t¥sn¥ní, p°es vodovodní trubky, kabely, chráni£ky aº po r·zné druhy fólií,

krycího materiálu a nespo£tu dal²ích výrobk·.[1, 2]

Velkou £ást této výroby tvo°í vytla£ování pro�l·. Pro�ly mohou mít r·zné tvary a

sloºitosti provedení. Od relativn¥ jednoduchých standardních tvar· aº po sloºité více-

komorové okenní rámy. Jejich výroba je náro£ný proces, p°i kterém je nutné neustále

hlídat výrobní parametry tak, aby výrobek odpovídal poºadovanému tvaru a kvalit¥.

�e²ení problém· vznikajících p°i výrob¥ je £asto stylem pokus-omyl, jelikoº ne vºdy

je na první pohled z°ejmé, kde chyba vzniká a jak ji napravit. K tomu, aby se po£et

t¥chto pokus· minimalizoval, nebo aby se jim mohlo p°edcházet je t°eba mít p°ehled o

kvalit¥ výrobku, zejména o jeho tvarové p°esnosti.

Získat p°esné rozm¥ry výrobku tak, aby jej bylo moºné porovnat s výkresovou do-

kumentací je v praxi tém¥° nemoºné. B¥ºn¥ pouºívaným m¥°ící nástrojem je posuvné

m¥°ítko, které ale umoº¬uje m¥°it pouze n¥které rozm¥ry výrobku. Tabulková p°esnost

tohoto nástroje je sice dostate£ná, ale skute£ná p°esnost závisí p°edev²ím na správném

umíst¥ní m¥°ících £elistí. Dal²ím, £asto pouºívaným zp·sobem je obkreslení pro�lu na

pr·svitný papír a optické srovnání tvaru pro�lu s vytisknutou p°edlohou. Tento zp·sob

m¥°ení je spí²e orienta£ní a nelze pomocí n¥j získat p°íli² p°esné hodnoty.

Problémy s m¥°ením mohou vy°e²it profesionální m¥°ící p°ístroje, které jsou velmi

p°esné a zpravidla také velmi drahé. Mají ale spoustu nevýhod. Krom¥ vysoké ceny

jsou v¥t²inou t¥ºké, ²patn¥ p°enosné a mají r·zná technická omezení, která nemusí

vyhovovat v²em druh·m výrobk·.

Mezi ru£ním m¥°ením a profesionálními nástroji neexistuje ºádná alternativa, která

by tuto mezeru vypl¬ovala. Proto ve �rm¥ Compuplast International a.s., která se mj.

zabývá problémy souvisejícími s vytla£ováním, vznikl poºadavek na realizaci nástroje,

který by umoº¬oval m¥°ení pro�lu jako celku a jeho p°ímé srovnání s poºadovaným

tvarem bez nutnosti po°izovat drahý hardware.
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I. TEORETICKÁ �ÁST
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1 Vytla£ování plastových pro�l·

Pro vytla£ování plastových pro�l· se pouºívá za°ízení zvané extruder. Úkolem tohoto

za°ízení je ze surového polymeru ve form¥ granulí, nebo prá²ku vytvo°it roztavenou

hmotu a tu následn¥ protla£it otvorem s poºadovaným tvarem. Extrudery je moºné

rozd¥lit na dva základní typy. Extrudery s kontinuální výrobou a extrudery s dávkovou

výrobou. Kontinuální extruder zpravidla vyuºívá k transportu hmoty rota£ní prvky,

dávkový extruder v¥t²inou pouºívá za°ízení na principu pístu. Tyto dva typy se mohou

dále d¥lit na extrudery jedno²nekové, více²nekové, diskové a spoustu dal²ích typ· podle

zam¥°ení výroby. [4]

1.1 Jedno²nekový extruder

Nejjednodu²²ím typem extruderu je jedno²nekový extruder. Tvo°í jej ²nek uzav°ený

v ocelovém válci, který je pohán¥n elektromotorem s p°evodovkou. Materiál ve form¥

granulí je pomocí násypky dávkován na za£átek ²neku do prostoru mezi ²nekem a

válcem. Otá£ením ²neku se materiál postupn¥ posunuje vp°ed. �nek je rozd¥len na

t°i zóny. Plnící, kompresní a vytla£ovací. Materiál postupn¥ prochází t¥mito zónami,

kde je £ím dál více stla£ován mezi ²nekem a st¥nou válce. Zp·sobeným t°ením vzniká

teplo, které je podpo°eno elektrickým vyh°íváním válce a materiál se postupn¥ m¥ní

v taveninu. Na konci válce projde roztavená hmota vytla£ovací hlavou, kde postupn¥

dostane poºadovaný tvar. Po výstupu z extruderu se výrobek chladí, p°ípadn¥ kalibruje

a dále zpracovává. [4, 5]

Obr. 1.1 Jedno²nekový extruder [5]

Na obrázku 1.1 je schéma jedno²nekového extruderu. A � plnící zóna, B � kompresní

zóna, C � vytla£ovací zóna, 1 � násypka, 2 � válec, 3 � ²nek, 4 � topná t¥lesa, 5 �

termo£lánky m¥°ící teplotu v zónách, 6 � lama£, 7 � vytla£ovací hlava. [5]
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1.2 Problémy p°i výrob¥

Vytla£ování plastových pro�l· je náro£ný proces probíhající za vysokého tlaku. Na

kvalitu výrobk· má vliv spousta parametr·, které musí být správn¥ nastaveny a re-

gulovány ve v²ech £ástech výrobní linky. Základní poºadovaná kritéria pro výrobu a

výrobek jsou:

1. tvarová p°esnost

2. kvalita povrchu

3. rychlost výroby

4. mechanické vlastnosti

Hlavní parametry, které ovliv¬ují kvalitu výroby jsou tlak a teplota. P°i vysoké

teplot¥ m·ºe docházet k ho°ení materiálu uvnit° extruderu. P°íli² vysoký tlak zase

m·ºe zp·sobit mechanické po²kození výrobní linky, roztrºení válce, nebo i vyst°elení

vytla£ovací hlavy z extruderu a zran¥ní obsluhy. V¥t²ina potíºí p°i výrob¥ se týká

p°edev²ím kvality výsledného výrobku. Problém· se m·ºe vyskytnout celá °ada, ale

v¥t²inou mají v²echny spojitost s tlakem a teplotou, a´ uº z d·vodu ²patn¥ nastavených

parametr· výrobní linky, nebo nevhodn¥ navrºenému tvaru vytla£ovací hlavy. [4]

1.2.1 Tvarová p°esnost

Jedním ze základních poºadavk· výroby je tvarová p°esnost výrobku. Problém·, které

zp·sobují tvarové deformace je celá °ada. P°í£inou m·ºe být nap°íklad p°íli² vysoká

rychlost výroby, nevhodný tvar vytla£ovací hlavy, opot°ebení sou£ástí výrobní linky,

nebo i samotný materiál, jehoº vlastnosti se mohou li²it i mezi jednotlivými ²arºemi.

1.2.1.1 Problém s distribucí materiálu

Problémy s distribucí materiálu ve vytla£ovací hlav¥ mohou mít mnoho p°í£in. Jejich

d·sledkem je nerovnom¥rné rozd¥lení hmoty ve vytla£ovací hlav¥ a vznik míst, kde

je materiálu p°ebytek, nebo kde materiál naopak chybí. D·vodem m·ºe být nap°í-

klad ²patn¥ navrºená vytla£ovací hlava. Tavenina díky svým fyzikálním vlastnostem

jen velmi neochotn¥ vtéká do úzkých ²t¥rbin a proto je správné rozvedení hmoty do

problematických míst klí£ové pro dosaºení správného tvaru pro�lu. Tento problém je

znázorn¥n na obrázku 1.2, kde je jasn¥ vid¥t velký p°ebytek hmoty na krajních st¥nách

pro�lu, který zp·sobuje zvln¥ní a nedostatek hmoty u prost°edního ºebra. [6]
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Obr. 1.2 Deformace pro�lu zp·sobená ²patnou distribucí
materiálu (zdroj: Compuplast Int. a.s.)

1.2.1.2 Stagnace materiálu

Tento problém také souvisí s tvarem tokového kanálu ve vytla£ovací hlav¥. Tavenina

se nepohybuje rovnom¥rn¥ rychle v celém pr·°ezu kanálu. �ím blíºe je ke st¥n¥, tím se

pohybuje pomaleji. V n¥kterých místech, jako jsou rohy a ²t¥rbiny se m·ºe tok hmoty

natolik zpomalit, ºe vlivem dlouhotrvající vysoké teploty dojde k degradaci materiálu

a zárove¬ k deformaci tvaru výsledného výrobku, jelikoº v n¥kterých místech není

dostatek hmoty pro dosáhnutí poºadovaného tvaru. [6]

1.2.1.3 Chlazení pro�l·

Velmi d·leºitým krokem p°i výrob¥ vytla£ovaných pro�l· je jejich chlazení po opu²t¥ní

vytla£ovací hlavy. Proces chlazení je zodpov¥dný za kvalitu povrchu, tvarovou p°esnost,

stabilitu a mechanickou odolnost výrobku.

Chlazení je problematické p°edev²ím u uzav°ených, nebo velmi £lenitých pro�l·, u

kterých je moºné ochlazovat pouze vn¥j²í st¥ny. Velký rozdíl teplot mezi vnit°ní a vn¥j²í

st¥nou pro�lu zp·sobí nerovnom¥rné smr²t¥ní a v daném míst¥ tak vznikne neºádoucí

prohnutí, viz obrázek 1.3. Deformace pro�lu se m·ºe projevit i v podélném sm¥ru

(obrázek 1.4). [3]
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Obr. 1.3 Deformace pro�lu vlivem ²patného
chlazení (zdroj: Compuplast Int. a.s.)

Obr. 1.4 Prohnutí pro�lu vlivem ²patného chlazení
(zdroj: Compuplast Int. a.s.)

1.2.2 Tokové nestability

Jedním z hlavních problém· p°i vytla£ování je nestabilní tok taveniny p°es vytla£ovací

hlavu, který m·ºe zp·sobit necht¥né vady výrobku. Dva hlavní problémy zp·sobené

nestabilitou toku jsou efekt ºralo£í k·ºe a lom taveniny. [4]

1.2.2.1 �ralo£í k·ºe

Efekt ºralo£í k·ºe se projevuje zm¥nou vzhledu a struktury povrchu výrobku. M·ºe do-

sahovat r·zné intenzity. Od zm¥ny lesku aº po citelné zdrsn¥ní povrchu. Na jeho vznik
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má vliv p°edev²ím teplota a rychlost vytla£ování. Zp·sobuje jej prudká zm¥na rychlosti

povrchové vrstvy výrobku t¥sn¥ po opu²t¥ní vytla£ovací hlavy. Pokud je zm¥na rych-

losti p°íli² velká, dojde vlivem p°íli²ného protaºení povrchové vrstvy k jejímu poru²ení

a vzniku typických vrás£itých útvar·. Princip tohoto jevu je znázorn¥n na obrázku 1.5.

[4]

Obr. 1.5 Princip vzniku efektu ºralo£í k·ºe [4]

1.2.2.2 Lom taveniny

Dal²í závaºnou deformací je lom taveniny. Na rozdíl od efektu ºralo£í k·ºe tento druh

deformace nepostihuje pouze povrch výrobku, ale celý jeho tvar. Vyskytovat se m·ºe

s r·znou intenzitou a vytvá°et tak r·zné zvln¥ní, spirály a dal²í necht¥né zm¥ny tvaru

výrobku. Vznik tohoto defektu m·ºe mít r·zné p°í£iny, které se mohou li²it pro r·zné

materiály a tvary tokového kanálu. Obecn¥ je zp·sobován vysokou hodnotou smykového

t°ení na st¥n¥ vytla£ovací hlavy. [4]
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Obr. 1.6 R·zné formy lomu taveniny [4]

1.2.3 Degradace materiálu

�astým problémem p°i výrob¥ vytla£ovaných pro�l· je degradace materiálu. M·ºe

zp·sobovat zm¥nu barvy výrobku, ztrátu mechanických vlastností a dal²í problémy.

Degradace se d¥lí podle p°í£iny jejího vzniku na tepelnou, mechanickou a chemickou.

[4]

1.2.3.1 Tepelná degradace

K tepelné degradaci dochází p°i vystavení polymeru vysoké teplot¥. Její vý²i ur£uje

pouºitý materiál a jeho tepelná stabilita. P°i degradaci dochází k depolymerizaci a

rozpadu makromolekul polymeru, £ímº materiál ztrácí své fyzikální vlastnosti. [4]

1.2.3.2 Mechanická degradace

Mechanická degradace vzniká p·sobením mechanického namáhání na taveninu. Zp·-

sobena je smykovým, nebo elonga£ním nap¥tím, p°ípadn¥ ob¥ma zárove¬. P·sobení

t¥chto sil zp·sobí roztrhání dlouhého °et¥zce makromolekuly polymeru. V¥t²inou se

vyskytuje spolu s tepelnou degradací, jelikoº p°i silné mechanické deformaci vzniká

velké mnoºství tepla. [4]

1.2.3.3 Chemická degradace

Chemická degradace vzniká p°i kontaktu polymeru s chemickou látkou. Existují dva

d·leºité typy chemické degradace. Solvolýza a oxidace. U solvolýzy se jedná p°edev²ím

o hydrolýzu. N¥které druhy polymer·, jako nap°íklad polyethylen a polyester ochotn¥

absorbují vodu a pro zamezení degradace musí být p°edem °ádn¥ vysu²eny. Oxida£ní

degradace je velmi b¥ºným typem degradace u polymer·. Vzniká p°i vysoké teplot¥ a

£asto se objevuje spolu s tepelnou degradací. [4]
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1.3 M¥°ení pro�l·

V²echny zmín¥né problémy, které mohou p°i výrob¥ vytla£ovaných plastových pro�l·

nastat, jsou d·sledkem nesprávn¥ zvolených parametr·, nevhodného materiálu, nebo

²patn¥ navrºené vytla£ovací hlavy. Aby bylo moºné zjednat nápravu, musí se nejprve

problém identi�kovat. Vzhledem k mnoºství parametr·, které ovliv¬ují výrobu a tvar

výrobku jde £asto o postup pokus�omyl. Hlavním kritériem kaºdé výroby je minimali-

zace prostoj· a £as, který se v¥nuje na odstran¥ní problému m·ºe být velmi drahý. Z

tohoto d·vodu je d·leºité co moºná nejlépe ur£it odchylku výrobku od jeho poºadova-

ného tvaru a najít tak místo, kde problém vzniká.

Nej£ast¥ji pouºívaným nástrojem je oby£ejné posuvné m¥°idlo, kterým je ale moºné

zm¥°it pouze n¥které rozm¥ry. Zkontrolovat celý pr·°ez pro�lu a porovnat jej s poºado-

vaným tvarem se tímto nástrojem nedá. Poºadovaný tvar je zpravidla dostupný pouze

ve form¥ technického výkresu ve formátu pro CAD software.

Aby bylo moºné zjistit skute£nou odchylku celého pro�lu, je pot°eba u°íznout z

vytla£eného pro�lu plátek a ten následn¥ pomoci specializovaného nástroje digitalizovat

a porovnat v po£íta£i s výkresem.
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2 Digitalizace pro�l·

D·vod· pro digitalizaci vytla£ovaných pro�l· m·ºe být n¥kolik. Krom¥ zmín¥ného m¥-

°ení a porovnávání s výkresovou dokumentací m·ºe být d·vodem nap°íklad tvorba pod-

klad· pro pro�l stejného, nebo podobného tvaru, jehoº dokumentace není k dispozici,

nebo pr·b¥ºná kontrola kvality výroby. K tomuto ú£elu je moºné pouºít specializované

p°ístroje, které jsou zpravidla p°esné a velmi drahé, nebo b¥ºné m¥°ící nástroje, které

pro tyto ú£ely p·vodn¥ ur£eny nejsou.

2.1 Profesionální nástroje

Profesionální nástroj ur£ený p°ímo pro plastiká°ský pr·mysl, který by umoº¬oval jak

kontrolu p°esnosti tvaru, tak i p°evod existujícího pro�lu do CAD modelu doposud

neexistuje. Profesionální nástroje se vesm¥s zam¥°ují pouze na srovnání tvaru a vy-

hodnocení odchylek pro�lu od výkresové dokumentace.

2.1.1 SCAN FIT & MEASURE

Jedním z t¥chto nástroj· je SCAN FIT & MEASURE. Je to 2D systém pro automa-

tické m¥°ení a porovnání tvaru vytla£ovaného pro�lu, vyvíjený softwarovou spole£ností

EngView Systems. Základ systému tvo°í plochý skener, který ve spojení s dodávaným

softwarem umoº¬uje zcela automatické porovnání tvaru pro�lu s p°edem p°ipraveným

CAD modelem. [7]

2.1.1.1 Parametry hardwaru uvedené výrobcem

• Maximální rozm¥ry pro�lu 300 × 400 mm

• Maximální vý²ka pro�lu 130 mm

• Odolné provedení

2.1.1.2 Schopnosti softwaru uvedené výrobcem

• Automatické zarovnání skenované £ásti s modelem

• Vizuální porovnání a generování report·

• P°esnost m¥°ení srovnatelní s digitálním posuvným m¥°idlem

• Moºnost nastavení tolerance rozm¥r·

• Skenování více £ástí najednou
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• Výstupní data v otev°eném formátu

M¥°ící systém je vhodný zejména pro vytla£ované plastové a hliníkové pro�ly, tru-

bi£ky, t¥sn¥ní, ploché výlisky a tvarované fólie. [7]

Obr. 2.1 M¥°ící systém Scan Fit
Scanner 200 [7]

2.1.2 Kamera s telecentrickým objektivem

Dal²í, o n¥co univerzáln¥j²í, ale stále profesionální m¥°ící nástroj je kamera vybavená

telecentrickým objektivem. Pat°í mezi £asto pouºívaná za°ízení v oblasti automati-

zace, strojového vid¥ní a automatického m¥°ení. Telecentrický objektiv je speciální typ

objektivu, který dokáºe snímat objekty bez perspektivního zkreslení. Pr·m¥r vstupní

£o£ky objektivu je stejný, jako úhlop°í£ka zorného pole. Hlavní výhoda telecentrického

objektivu je v tom, ºe se jeho zv¥t²ení nem¥ní vzhledem k hloubce. Tento princip

snímání je znázorn¥n na obrázku 2.2. [8, 9]

Obr. 2.2 Princip snímání obrazu klasickým objektivem (naho°e) a
telecentrickým (dole) [8]

Tato vlastnost zp·sobuje, ºe je snímaný objekt zobrazován stále stejn¥, bez ohledu

na tom, v jaké vzdálenosti od objektivu se nachází. Pokud by byly pomocí telecent-

rického objektivu snímány dva stejné p°edm¥ty, z nichº jeden by se nacházel ve v¥t²í
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vzdálenosti od objektivu, neº druhý, tak by z výsledného snímku nebylo moºné ur£it,

který z nich to je. P°i snímání stejné scény klasickým objektivem by byl vzdálen¥j²í

p°edm¥t na snímku men²í. Díky tomuto jevu je moºné telecentrický objektiv pouºít pro

velmi p°esné m¥°ení. Jeho nevýhodou je ale vysoká cena a omezená velikost snímaného

p°edm¥tu. [8, 9]

2.2 B¥ºné dostupné nástroje

B¥ºn¥ dostupné, neprofesionální nástroje, které jsou schopné zaznamenat tvar n¥jakého

objektu jsou v podstat¥ pouze dva. Skener a fotoaparát. Na první pohled je z°ejmé, ºe

pro ú£ely digitalizace a m¥°ení vytla£ovaných pro�l· není uzp·soben ani jeden z nich.

Na rozdíl od profesionálních nástroj· ale mají jednu velkou výhodu. Jsou natolik roz²í-

°ené, ºe jsou v¥t²inou vºdy po ruce a jejich po°izovací hodnota je oproti profesionálnímu

vybavení zanedbatelná.

2.2.1 Skener

První z dvojice nástroj· je skener. Jedná se o za°ízení, které slouºí pro p°evod gra�ckých

p°edloh do digitální formy pro zpracování na po£íta£i. Nej£ast¥ji se jedná o ploché

p°edm¥ty, jako jsou dokumenty, nebo �lmy. Jedním z hlavních parametr· skeneru je

jeho rozli²ení, ve kterým je schopen obraz zaznamenat. [10]

Skener bývá vybaven v¥t²inou °ádkovým CCD sníma£em, který obsahuje t°i °ady

sv¥tlocitlivých bun¥k, kaºdou pro jednu základní barvu barevného spektra RGB. Tento

sníma£ zaznamená vºdy celou ²í°ku svého rozsahu najednou a následn¥ se posune

pomocí krokového motorku o jeden °ádek dál. (N¥které skenery mohou místo sníma£e

posunovat p°edlohu). Takto se postupuje °ádek po °ádku, dokud se nezaznamená celá

plocha p°edlohy. Rozli²ení skeneru je tedy dáno jednak po£tem sv¥tlocitlivých bun¥k v

jednom °ádku a jednak velikostí jednoho kroku krokového motorku. Hodnota rozli²ení

se udává v jednotkách DPI. U n¥kterých, p°eváºn¥ levn¥j²ích skener· m·ºe být rozli²ení

v °ádku a sloupci rozdílné. V tom p°ípad¥ se udávají dv¥ hodnoty. [10]

Pro digitalizaci vytla£ovaných pro�l· není v¥t²ina b¥ºných skener· p°izp·sobena.

Vhledem k jejich zam¥°ení p°eváºn¥ na skenování dokument· mají mezi snímací plo-

chou a krytem jen velmi málo místa. V p°ípad¥ skenování pro�l· se tak neobejdou bez

dodate£né úpravy.

Druhým velkým problémem u klasických skener· je nasvícení p°edm¥tu ze spodní

strany. P°i skenování dokument· je osv¥tlení skenované strany nezbytné pro správné

zachycení jejich obsahu. P°i skenování pro�l· ale dochází k n¥kterým necht¥ným jev·m.

U sv¥tlých, nebo lesklých pro�l· dochází k odraz·m sv¥tla od bo£ních hran pro�lu,

které pak na snímku vytvá°í necht¥né odlesky, viz obrázek 2.3. Opa£ný problém nastává
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u tmavých pro�l·, které je velmi t¥ºké na naskenovaném snímku rozeznat od £erného

pozadí.

Obr. 2.3 Problémy p°i skenování pro�l·

2.2.2 Fotoaparát

Druhým, b¥ºn¥ dostupným nástrojem pro záznam obrazu je digitální fotoaparát. Jedná

se o za°ízení, které stejn¥ jako skener vyuºívá ke snímání obrazu nej£ast¥ji CCD sníma£.

Ten, na rozdíl od skeneru není lineární, ale plo²ný. Tvo°í jej dvourozm¥rná m°íºka sv¥t-

locitlivých bod·, které bývají v p°ípad¥ barevného fotoaparátu vybaveny barevnými

�ltry pro rozli²ení jednotlivých barevných sloºek RGB spektra. [11]

Kvalitu fotoaparátu ur£uje spousta parametr·, jako je rozli²ení a fyzické rozm¥ry

sníma£e, kvalita optické soustavy a mnoho dal²ích. Typickými problémy u digitálního

fotoaparátu jsou r·zná zkreslení obrazu. Tangenciální zkreslení, které je zp·sobeno

nep°esnou montáºí sníma£e, radiální zkreslení, které zp·sobuje optická soustava a per-

spektivní zkreslení, které je dáno polohou snímaného p°edm¥tu ke kame°e. Poslední

zmín¥né zkreslení umí odstranit speciální telecentrický objektiv. Ten ale nepat°í mezi

b¥ºn¥ dostupné nástroje. [11, 16]

V p°ípad¥ pouºití fotoaparátu, jako nástroje pro digitalizaci a m¥°ení pro�l· je dal-

²ím problémem neznámá vzdálenost foceného p°edm¥tu od sníma£e. Pokud je p°edm¥t

umíst¥n dále od fotoaparátu, tak na po°ízeném snímku zabírá men²í plochu, neº kdyº

je blíºe. Tento problém zp·sobuje, ºe není moºné ur£it skute£nou velikost p°edm¥tu

bez znalosti jeho aktuální vzdálenosti.

Oproti skeneru má ale velkou výhodu v tom, ºe je daleko univerzáln¥j²í. Není závislý

na tvaru, rozm¥rech ani barv¥ pro�lu a nevyºaduje ºádnou dodate£nou hardwarovou

úpravu. Druhou výhodou je jeho obrovská roz²í°enost. Tém¥° kaºdý má u sebe fotoapa-

rát v podob¥ kamery zabudované v mobilním telefonu. Vhodnou softwarovou úpravou

je zárove¬ moºné n¥která zmín¥ná zkreslení odstranit. Jejich matematickému popisu a

moºnostem odstran¥ní se v¥nuje následující kapitola.
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3 Knihovna OpenCV

OpenCV je multiplatformní knihovna pro zpracování obrazu a po£íta£ové vid¥ní. �í-

°ena je pod 3 bodovou licencí BSD a je tak moºné ji vyuºít pro komer£ní aplikace s

uzav°eným kódem. Samotná knihovna je napsána p°eváºn¥ v jazyce C a C++ s pod-

porou moderních výpo£etních technologií, jako jsou CUDA a OpenCL. Knihovna je

distribuována v p°eloºené form¥ usnad¬ující její pouºití na konkrétní platform¥, nebo

ve form¥ zdrojových kód·. O�ciáln¥ je podporovaná velká ²kála opera£ních systém·.

Z desktopových jsou to Windows, Linux, Android, Mac Os, FreeBSD a OpenBSD. Z

mobilních jsou to Android, Maemo a iOS. Pro vývoj aplikací je moºné pouºít krom¥

jazyka C a C++ také jazyky Python, Java a Matlab. Pro celou knihovnu je zpracována

velmi kvalitní dokumentace, spousta návod· a tutoriál·. Díky v²em t¥mto vlastnostem

je knihovna OpenCV pouºívána v mnoha aplikacích pro zpracování obrazu a po£íta-

£ové vid¥ní. Mezi velkými spole£nostmi vyuºívajícími tuto knihovnu je moºné najít

nap°íklad Google, Microsoft, IBM, Hondu a spoustu dal²ích. [12]

3.1 Model Kamery

Základním prvkem po£íta£ového vid¥ní je digitální kamera. Jedná se o za°ízení, které

umoº¬uje zachytit dopadající zá°ení a zaznamenat tak realitu podobn¥, jako to umí

lidské oko. Paprsek sv¥tla, který vychází z n¥jakého zdroje zá°ení, jako je nap°íklad

ºárovka, nebo slunce, je po st°etnutí s objektem £áste£n¥ absorbován a £áste£n¥ odra-

ºen. Odraºený paprsek poté dopadne na sítnici oka, nebo na snímací £ip kamery, £ímº

se získá energie paprsku. Ta se následn¥ interpretuje jako barva povrchu p°edm¥tu, od

kterého se paprsek odrazil. [13]

Obr. 3.1 Princip dírkové komory [13]
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Pro po£íta£ové zpracování obrazu zachyceného digitální kamerou je nezbytné v¥d¥t,

co je na snímku ve skute£nosti zobrazeno. K tomuto ú£elu slouºí matematický model,

který vychází z historicky nejjednodu²²í kamery, dírkové komory. Jedná se o velice

jednoduché za°ízení, které je tvo°eno st¥nou, uprost°ed které je malá dírka. Z jedné

strany st¥ny se nachází poºadovaná scéna a z druhé strany je umíst¥no plátno. Paprsek

sv¥tla prochází dírkou ve st¥n¥ a na plátno promítá obraz scény z druhé strany st¥ny.

[13, 15]

Popis takovéto kamery je velice jednoduchý, jelikoº je de�nována pouze jedním pa-

rametrem, vzdáleností dírky od projek£ní obrazové roviny (plátna). Tento parametr

se nazývá ohnisková vzdálenost. Pom¥r reálné velikosti p°edm¥tu ku jeho vzdálenosti

od dírky je shodný s pom¥rem zobrazené velikosti p°edm¥tu ku vzdálenosti plátna od

dírky. Princip je zobrazen na obrázku 3.1. Tento vztah je moºné vyjád°it vzorcem 3.1

[13, 15]

− x = f
X

Z
(3.1)

Obr. 3.2 Upravený model dírkové komory [13]

Tato reprezentace má ale jednu nevýhodu. Obraz na projek£ním plátn¥ je vºdy p°e-

vrácený oproti originálu. Tohoto jevu je moºné se zbavit zám¥nou obrazové roviny

a roviny s dírkou. Jedná se o úpravu, která je na reálné dírkové komo°e neprovedi-
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telná, ale z matematického hlediska je ekvivalentní p·vodnímu modelu. Místo dírky

tak vznikne bod, který se nazývá st°ed projekce obr. 3.2. Vztah mezi reálným objek-

tem a promítnutým objektem na obrazové rovin¥ se touto úpravou zjednodu²í (vzorec

3.2) a je tak moºné p°ímo promítnout bod reálného objektu Q=(X,Y,Z) do obrazového

bodu q=(x,y,f). [13, 15]

x

f
=

X

Z
(3.2)

V ideálním p°ípad¥ by tento model kamery byl dosta£ující. Pro reálnou kameru je

pot°eba vzít v potaz nedostatky, které mohly vzniknout p°i výrob¥. V jednoduchém

modelu na obr. 3.2 prochází optická osa p°esným st°edem obrazové roviny, v p°ípad¥

digitální kamery st°edem snímacího £ipu. V praxi je ov²em nereálné umístit st°ed £ipu

p°esn¥ do st°edu optické osy. Zavádí se proto parametry cx a cy, které ur£ují posunutí

optického st°edu oproti st°edu obrazové roviny. [13, 15]

Dal²í problém reálné kamery je hodnota ohniskové vzdálenosti. Ta je dána nejenom

vzdáleností £ipu od st°edu projekce, ale také vlastními rozm¥ry snímacího £ipu. Ty je

moºné ur£it v jednotkách pixel na milimetr. P°esnou fyzickou velikost £ipu je v praxi

nereálné zjistit, je znám pouze údaj o rozli²ení v pixelech. Co je ov²em známý údaj je

vzdálenost mezi £ipem a st°edem projekce, který je moºné ur£it v milimetrech. Skute£ná

hodnota ohniskové vzdálenosti je pak dána sou£inem velikosti £ipu a vzdáleností od

st°edu projekce f = F.s, £ímº vznikne hodnota, jejíº jednotkou je pouze pixel.

Velkým problémem p°eváºn¥ levných kamer jsou obdélníkové body sníma£e. �ip

má proto jinou velikost v pixelech na milimetr na vý²ku a jinou na ²í°ku. Je proto

pot°eba zavést dva parametry ohniskové vzdálenosti. Jeden pro osu X a druhý pro osu

Y. Výsledný model kamery se v²emi t¥mito nedostatky popisuje vzorec 3.3. [13, 15]

x = fx
X

Z
+ cx, y = fy

Y

Z
+ cy, (3.3)

Pomocí tohoto vzorce je moºné jednodu²e promítnout reálný bod (X, Y, Z) do ob-

razové roviny (x, y). Výsledný model je vhodné upravit do maticového tvaru s vyuºitím

homogenních sou°adnic 3.5. [13, 16]

q = MQ (3.4)
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q =

fx 0 cx

0 fy cy

0 0 1


XY
Z

 , kde q =

xy
w

 , (3.5)

3.2 Zkreslení objektivu

Dal²ím prvkem, který výrazn¥ zasahuje do p°esnosti zachycení reálné scény je objektiv.

P°edev²ím u levn¥j²ích kamer, kde není kladen velký d·raz na kvalitu a p°esnost mon-

táºe bývá zkreslení objektivu jedním z hlavních faktor· ovliv¬ujících kvalitu a p°esnost

výsledných snímk·. Rozli²ují se dva druhy zkreslení. Radiální, které je dané tvarem

objektivu a tangenciální, které je zp·sobeno nep°esnou montáºí.

3.2.1 Radiální zkreslení

Radiální zkreslení je radiáln¥ symetrické okolo optické osy. Zp·sobuje efekt známý jako

soudkovité, nebo podu²kovité zkreslení. Velice výrazný je tento efekt u objektiv· typu

rybí oko. Intenzita zkreslení je závislá na vzdálenosti od optické osy. P°ímo uprost°ed

je zkreslení nulové a na okraji je zkreslení nejv¥t²í. [13, 15]

Obr. 3.3 Vznik radiálního zkreslení [13]

Na obrázku 3.3 je znázorn¥n princip vzniku radiálního zkreslení. Paprsek sv¥tla

procházející optickým st°edem není zak°ivením objektivu nijak ovlivn¥n. �ím dále od

optického st°edu paprsek objektivem prolétá, tím více je ohýbán. Kvalitní objektivy

tento efekt dokáºí £áste£n¥ eliminovat svou konstrukcí optické soustavy. Toto zkreslení

je moºné popsat za pomoci Taylorova rozvoje. Pro standardní objektivy posta£í dva

£leny rozvoje. Pro objektivy s velkým zkreslením typu typu rybí oko je pot°eba pouºít

t°i £leny. [13]
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xopraveno = x(1 + k1r
2 + k2r

4 + k3r
6)

yopraveno = y(1 + k1r
2 + k2r

4 + k3r
6)

(3.6)

Pomocí vzorce 3.6 je moºné radiální zkreslení opravit. Koe�cienty x a y jsou p·vodní

sou°adnice obrazového bodu, xopraveno a yopraveno jsou opravené sou°adnice obrazového

bodu na obrázku bez zkreslení. Koe�cienty k1, k2 a k3 ur£ují míru zkreslení a parametr

r udává vzdálenost bodu od optické osy. [16]

3.2.2 Tangenciální zkreslení

Tangenciální zkreslení nastane v p°ípad¥, kdy snímací £ip není umíst¥n p°esn¥ paraleln¥

s rovinou obrazu. Jedna strana sníma£e se dostane blíºe k objektivu, neº druhá strana

a vznikne tak rozdílná hodnota zv¥t²ení na r·zných £ástech snímku. Hlavním d·vodem

vzniku tohoto zkreslení je nedostate£ná kvalita výroby a montáºe, proto se projevuje

p°edev²ím u levných za°ízení. Princip jeho vzniku je znázorn¥n na obrázku 3.4 .[13, 15]

Obr. 3.4 Vznik tangenciálního zkreslení u nekvalitn¥ vyrobené kamery. [13]

Pro matematický popis tangenciálního zkreslení posta£í dva parametry, p1 a p2.

Opravu snímku je pak moºné provést pomocí vzorce 3.7.

xopraveno = x+ [2p1y + p2(r
2 + 2x2)]

yopraveno = y + [p1(r
2 + 2y2) + 2p2x]

(3.7)
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3.3 Kalibrace

Aby bylo moºné zbavit se v²ech vý²e popsaných vad, je pot°eba ur£it n¥kolik parametr·

kamery. Jmenovit¥ se jedná o matici vnit°ních parametr· kamery s koe�cienty fx, fy,

cx a cy. Dva parametry k1 a k2 pro eliminaci radiálního zkreslení a dva parametry p1 a

p2 pro odstran¥ní tangenciálního zkreslení. Celkem se tedy jedná o osm parametr·. K

jejich ur£ení slouºí postup zvaný kalibrace kamery, který knihovna OpenCV umoº¬uje

provést.

Principem kalibrace je po°ízení série snímk· p°edm¥tu se známou strukturou a iden-

ti�kovatelnými body. Teoreticky je moºné pouºít libovolný p°edm¥t, který spl¬uje tyto

dv¥ podmínky, ale z d·vodu jednoduchosti a p°esnosti se pouºívá plochý p°edm¥t,

typicky s ²achovnicovým vzorem (dále nazývaný jako kalibra£ní obrazec). Aby byla ka-

librace moºná, snímky musí být po°ízeny v r·zných pozicích a úhlech ke kalibra£nímu

obrazci.

3.3.1 Kalibra£ní obrazce

Knihovna OpenCV nabízí n¥kolik variant kalibra£ních obrazc·, pomocí kterých lze

ur£it body pro následnou kalibraci kamery. Základní obrazce jsou ²achovnice (obr. 3.5)

a m°íºka kruhových bod·, p°ípadn¥ varianta s asymetricky uspo°ádanými kruhy (obr.

3.6). [12]

Obr. 3.5 Kalibra£ní obrazec: ²achovnice

3.4 Roz²í°ená realita

Knihovna OpenCV dokáºe vyuºít kalibra£ní obrazce i jiným zp·sobem. Na základ¥

snadno detekovatelného vzoru se známými rozm¥ry dokáºe ur£it jeho p°ibliºnou po-

lohu a nato£ení ke kame°e. Na základ¥ t¥chto údaj· umí odhadnout pozici sou°adného
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Obr. 3.6 Kalibra£ní obrazec: asymetrická m°íºka
kruhových bod· [12]

systému obrazce a vyuºít ji pro ú£ely roz²í°ené reality. Tato vlastnost m·ºe být velice

uºite£ná i pro pot°eby digitalizace objekt·, které se v obraze nacházejí a jejichº polohu

je pot°eba p°esn¥ ur£it.

Standardní kalibra£ní obrazce ale nejsou pro roz²í°enou realitu p°íli² vhodné. Hlav-

ním problémem je nejednozna£né nato£ení ²ablony na snímku, protoºe jsou v²echny

detekovatelné body stejné. Pro práci s roz²í°enou realitou slouºí v OpenCV modul

ArUco (od anglického výrazu Augmented reality), který £áste£n¥ vychází z kalibra£-

ních obrazc· a dokáºe je i nahradit.

3.4.1 ArUco

Základem roz²í°ené reality je p°esné ur£ení sou°adnic na snímku, do kterých má být

dodate£n¥ vykreslen zvolený 3D objekt. K tomuto ú£elu poskytuje modul ArUco spe-

ciální 2D kódy, které umoº¬ují jednozna£n¥ de�novat pozici sou°adného systému na

vybraném míst¥.

ArUco kódy jsou podobné b¥ºn¥ pouºívaným 2D kód·m, nap°íklad QR code, nebo

Data Matrix. Je to dáno velmi dobrou detekovatelností v²ech t¥chto kód· v obraze. Na

rozdíl od b¥ºných kód· nenesou ArUco kódy ºádnou informaci, kterou by bylo moºné

z nich p°ímo dekódovat. Tyto kódy jsou generovány na základ¥ slovníku, ve kterém je

kaºdému kódu p°i°azen ur£itý index. Po p°e£tení kódu se pak pouze vyhledá ve slovníku

jeho odpovídající pozice. Pokud se na snímku nachází t¥chto kód· více a pokud je

známá jejich skute£ná vzájemná poloha, tak je moºné ur£it jejich relativní polohu ke

kame°e a odhadnout pozici jejich sou°adnicového systému. P°i vytvá°ení slovníku se

zárove¬ bere v potaz po£et pot°ebných kód· a pokud je to moºné, vygenerují se s
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co moºná nejv¥t²í vzájemnou Hammingovou vzdáleností. Tím je umoºn¥na správná

detekce i na ²patn¥ £itelném snímku. [17]

Obr. 3.7 R·zné ArUco kódy [17]

Detekce a zpracování kód· probíhá v n¥kolika krocích. Prvním z nich je vy�ltro-

vání vhodných kandidát·. K tomu se pouºívá metoda prahování, kdy se podle zvolené

prahové hodnoty barvy zm¥ní snímek na dvoubarevný, typicky £erný a bílý. V tomto

snímku se následn¥ vyhledají v²echny objekty, které by mohly být ArUco kódy. Celý

tento krok je moºné provést pro n¥kolik úrovní prahové hodnoty, aby bylo moºné dete-

kovat kódy i na snímcích s r·znou intenzitou osv¥tlení. P°íklad pouºití prahové hodnoty

je na obrázku 3.8. [17]

Nalezení kandidáti se následn¥ vy�ltrují podle nastavených kritérií minimální a ma-

ximální velikosti vztaºené k velikosti snímku. U ostatních kandidát· se provede pokus

o dekódování jejich binární reprezentace. Postup dekódování je znázorn¥n na obrázku

3.9. Nejprve se opraví perspektivní zkreslení kódu a následn¥ se ur£í barva kaºdého

jeho segmentu. Ta se poté p°evede do binární reprezentace a pomocí slovníku se ur£í,

jestli se jedná o n¥který z AruCo kód·. [17]

Nalezením ArUco kódu v obraze se získá informace o jeho p°ibliºné poloze ke kame°e.

Tím, ºe jsou ArUco kódy nesymetrické je moºné jednozna£n¥ ur£it jejich nato£ení. Tyto

informace o poloze a nato£ení jsou dosta£ující k tomu, aby bylo moºné ur£it lokální

sou°adnicový systém kaºdého kódu (obrázek 3.10).

ArUco kódy je moºné uspo°ádat do pravidelné m°íºky a ur£it tak sou°adnicový

systém celé pokryté plochy. Dal²ím moºným vyuºitím je kalibrace kamery, jelikoº stejn¥

jako klasické kalibra£ní obrace poskytují informace o vzájemné poloze bod· na snímku,

jejichº relativní rozm¥ry a vzdálenosti jsou p°edem známé.

3.4.2 ChArUco

ChArUco je speciální typ obrazce pro kalibraci kamery a roz²í°enou realitu. Vznikl

kombinací klasického ²achovnicového vzoru (chessboard) a ArUco kód·. Díky tomuto
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Obr. 3.8 Pouºití prahování p°i detekci ArUco kód· [17]

Obr. 3.9 Dekódování ArUco kódu [17]

spojení m·ºe vyuºívat jejich výhody najednou. Z ²achovnicového vzoru p°esnost a z

ArUco jednozna£n¥ de�novanou polohu. [18]

ChArUco obrazec je tvo°en £ernobílou ²achovnicí, která má v kaºdém bílém polí£ku

umíst¥n jedine£ný ArUco kód. Detekování tohoto obrazce probíhá ve dvou hlavních

krocích. Nejprve jsou ur£eny polohy v²ech ArUco kód·. Jelikoº má kaºdý kód svou

p°edem známou polohu k ostatním kód·m, je moºné ur£it p°ibliºnou polohu a nato£ení

celého obrazce na snímku. Ve druhém kroku se pro zp°esn¥ní vyuºije ²achovnicový vzor.

Mezi kaºdými dv¥ma ArUco kódy se na úhlop°í£ce nachází bod, ve kterém se dotýkají
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Obr. 3.10 Nalezení sou°adnicového systému ArUco kód· [17]

dva £erné £tverce. Tento bod je p°esn¥ v polovin¥ vzdálenosti mezi dv¥ma ArUco kódy,

jejichº poloha je známá z p°edchozího kroku. Detekce polohy ArUco kód· není zcela

p°esná, proto se vypo£ítaná poloha bodu nemusí shodovat se skute£ným pr·se£íkem

£erných £tverc·. Pro ur£ení p°esné polohy se okolo vypo£ítaného bodu vytvo°í okolí, ve

kterém se hledá skute£ný pr·se£ík. Tímto postupem vznikne matice bod·, které mají

známou vzájemnou polohu a jsou jednozna£n¥ de�nované pomoci sousedních ArUco

kód·. [18]

Obr. 3.11 ChArUco obrazec [18]

ChArUco obrazec je rovn¥º moºné pouºít pro kalibraci kamery. Oproti klasickým

kalibra£ním obrazc·m má jednu velikou výhodu. Jelikoº je moºné kaºdému bodu p°i-

°adit jednozna£ný identi�kátor, nemusí být obrazec na snímku zachycen celý. Pokud je

n¥který bod p°ekrytý, nebo se nachází mimo snímek, je moºné dopo£ítat jeho polohu

a pouºít ji pro dal²í zpracování. [18]
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4 Bézierova k°ivka

Tato kapitola se zam¥°uje p°edev²ím na konstrukci a výpo£ty kubických Bézierovych

k°ivek, které jsou implementovány jako nástroj pro ru£ní digitalizaci pro�l· v praktické

£ásti této práce.

Bézierova k°ivka je jednou z mnoha parametrických k°ivek. Pojmenovaná je po fran-

couzském inºenýru Pierru Bézierovi. Nezávisle na n¥m ji vymyslel i matematik Paul de

Casteljau a tak není zcela jisté, komu pat°í prvenství. Bézierovy k°ivky jsou v podstat¥

Bernsteinovy polynomy, rodina matematických funkcí, kterou zkoumal Sergei Natano-

vich Bernstein. Bézierovy k°ivky jsou velice oblíbené pro kreslení sloºitých gra�ckých

prvk· nap°í£ r·znými gra�ckými editory, CAD programy a v²ude tam, kde je pot°eba

pracovat s jednodu²e editovatelnými k°ivkami. [19]

Bézierovy k°ivky jsou typicky de�novány mezi po£áte£ním a koncovým bodem. Tvar

k°ivky se poté upravuje jedním, nebo více °ídícími body v závislosti na tom, koliká-

tého je stupn¥. Pro ru£ní kreslení v gra�ckých editorech se v¥t²inou pouºívají k°ivky

kvadratické a kubické, respektive druhého a t°etího °ádu.

4.1 Konstrukce k°ivky

Bézierova k°ivka je de�nována mezi dv¥ma body na intervalu 0 � 1, který bývá ozna-

£ován jako sou°adnice t. Obecná Bézierova funkce pro výpo£et k°ivky stupn¥ n je ve

vzorci 4.1. [19]

Bezier(n, t) =
n∑

i=0

(
n

i

)
(1− t)n−i · ti · Pi (4.1)

Z obecné Bézierovy funkce se dosazením stupn¥ 3 za n získá rovnice pro výpo£et

kubické Bézierovy k°ivky (vzorec 4.2), kde P1 tvo°í po£áte£ní bod, P2 koncový bod a

C1, C2 jsou °ídící body. [19]

CubicBezier(t) = P1 · (1− t)3 + C1 · 3 · (1− t)2 · t+ C2 · 3 · (1− t)2 + P2 · t3 (4.2)

Vzorec 4.2 je moºné jednoduchou úpravou p°evést do maticového tvaru 4.3, který je

pro po£íta£ové zpracování vhodn¥j²í. Zárove¬ umoº¬uje snáze provád¥t dal²í operace

a výpo£ty s Bézierovou k°ivkou. [19]
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CubicBezier(t) =
[
1 t t2 t3

]
·


1 0 0 0

−3 3 0 0

3 −6 3 0

−1 3 −3 1

 ·

P1

C1

C2

P2

 (4.3)

Pokud je pot°eba zjistit pouze pr·b¥h Bézierovy k°ivky, nap°íklad kv·li jejímu vy-

kreslení, je moºné pouºít itera£ní de Casteljau algoritmus. [19]

4.2 Rozd¥lení k°ivky

Jednou z operací, kterou je moºné pomoci maticového zápisu snadno provést je roz-

d¥lení Bézierovy k°ivky v ur£eném bod¥ tak, aby tvar dvou men²ích k°ivek p°esn¥

odpovídal p·vodnímu tvaru.

Nejprve je nutné de�novat bod z, ve kterém má být k°ivka rozd¥lena. Tento bod

m·ºe být libovolný bod na intervalu 0 � 1. Cílem je najít sou°adnice bod· dvou nov¥

vzniklých k°ivek. Do p·vodní funkce pro výpo£et k°ivky je t°eba p°idat d¥lící bod z

(4.4). [19]

CubicBezier(t) =
[
1 (z · t) (z · t2) (z · t3)

]
·


1 0 0 0

−3 3 0 0

3 −6 3 0

−1 3 −3 1

 ·

P1

C1

C2

P2



CubicBezier(t) =
[
1 t t2 t3

]
·


1 0 0 0

0 z 0 0

0 0 z2 0

0 0 0 z3

 ·


1 0 0 0

−3 3 0 0

3 −6 3 0

−1 3 −3 1

 ·

P1

C1

C2

P2



(4.4)

Sérií úprav pomocí lineární algebry vzniknou dv¥ funkce pro intervaly 0 � z a z �

1. Vzorec 4.5 je pro výpo£et první £ásti Bézierovy k°ivky. Vzorec 4.6 je pro výpo£et

druhé poloviny. [19]

LeftBezier =


1 0 0 0

−(z − 1) z 0 0

(z − 1)2 −2 · (z − 1) · z z2 0

−(z − 1)3 3 · (z − 1)2 · z −3 · (z − 1) · z2 z3

 ·

P1

C1

C2

P2

 (4.5)



UTB ve Zlín¥, Fakulta aplikované informatiky
	

35

RightBezier =


−(z − 1)3 3 · (z − 1)2 · z −3 · (z − 1) · z2 z3

0 (z − 1)2 −2 · (z − 1) · z z2

0 0 −(z − 1) z

0 0 0 1

 ·

P1

C1

C2

P2

 (4.6)

4.3 Manipulace s k°ivkou

Zm¥nit tvar Bézierovy k°ivky je moºné pomocí zm¥ny sou°adnic °ídících bod·. Tato

úprava ale není p°íli² intuitivní a vyºaduje jisté zku²enosti s kreslením k°ivek. Pro

b¥ºného uºivatele je mnohem jednodu²²í m¥nit tvar k°ivky p°ímo p°etaºením n¥které

její £ásti na poºadované místo.

Obr. 4.1 ABC body na Bézierov¥
k°ivce [19]

Aby bylo moºné zachovat b¥hem p°etahování k°ivky její tvar, je nutné ur£it tzv.

ABC pom¥r. Jedná se o hodnotu vypo£ítanou jako pom¥r délek úse£ek mezi body

AB a BC zobrazených na obrázku 4.1. Bod B leºí na k°ivce v míst¥, které má být

p°etaºeno (typicky tam, kde jej uºivatel zvolil stisknutím tla£ítka my²i). Bod A leºí na

úse£ce tvo°ené °ídícími body C1 a C2 v bod¥ první iterace de Casteljau algoritmu pro

stejnou hodnotu t, jako má zvolený bod B. Bod C vznikne jako pr·se£ík mezi p°ímkou

vzniklou z úse£ky AB a úse£kou mezi po£áte£ním bodem P1 a koncovým bodem P2.

Pro kvadratickou a kubickou k°ivku je moºné pom¥r ABC vypo£ítat i pouze ze znalosti

hodnoty t, viz vzorec pro kubickou Bézierovu k°ivku 4.8. [19]

A = (C2 − C1) · t+ C1 (4.7)

ABCratio(t) =

∣∣∣∣t3 + (1− t)3 − 1

t3 + (1− t)3

∣∣∣∣ (4.8)
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Po p°etaºení zvoleného bodu B na novou pozici B' je pot°eba ur£it nové umíst¥ní

bodu A'. To lze snadno vypo£ítat ze známého pom¥ru ABC podle následujícího vzorce

4.9. [19] Pozice bodu C se p°etaºením nezm¥ní.

A′ = B′ − C −B′

ABCratio
(4.9)

Obr. 4.2 P°etaºení bodu na kubické Bézierov¥ k°ivce [19]

Samotný pom¥r ABC pro zachování tvaru k°ivky nesta£í. Dále je t°eba za�xovat i

pozici bod· e1 a e2 vzhledem bodu B. Tyto dva body se nachází v míst¥ druhé iterace

de Casteljau algoritmu, viz obrázek 4.2. [19]

Nové pozice °ídících bod· se vypo£ítají pomocí vzorc· 4.10 a 4.11, které rovn¥º

vychází z algoritmu de Casteljau. [19]

v1 = A′ +
e1 − A′

1− t

v2 = A′ +
e2 − A′

t

(4.10)

C1 = P1 +
v2 − P1

t

C2 = P2 +
v2 − P2

1− t

(4.11)
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II. PRAKTICKÁ �ÁST
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5 Vlastní softwarové °e²ení

V²echny profesionální nástroje pro m¥°ení a kontrolu kvality vytla£ovaných pro�l· jsou

zaloºeny na speciálním hardwaru, který umoº¬uje dosáhnutí vysoké p°esnosti. Nevý-

hodou je jejich vysoká po°izovací cena. Oproti tomu b¥ºn¥ pouºívané nástroje, jako je

posuvné m¥°ítko, umoº¬ují m¥°it pouze n¥které rozm¥ry. Celková kontrola tvaru pro�lu

pouze optickým srovnáním se uº m¥°ením nedá nazvat v·bec, p°itom ur£ení odchylky

a místa jejího vzniku je zcela zásadní pro rychlé sjednání nápravy. Mezi ru£ním m¥°e-

ním a profesionálními p°ístroji je obrovský rozdíl jak v cen¥, tak v moºnostech m¥°ení.

�ádný alternativní systém, který by umoº¬oval roz²í°ené moºnosti m¥°ení a p°itom

nevyºadoval drahý hardware doposud neexistuje.

Z tohoto d·vodu vznikl ve �rm¥ Compuplast International a.s. poºadavek na vy-

tvo°ení nástroje pro m¥°ení pro�l·, který by vypl¬oval mezeru mezi ru£ními m¥°ícími

nástroji a profesionálními systémy.

5.1 Poºadavky

5.1.0.1 Funk£ní poºadavky

• M¥°ení v²ech vnit°ních a vn¥j²ích rozm¥r· pro�l·

• M¥°ení úhl·

• Srovnání pro�lu s poºadovaným tvarem

• Archivace pro�l·

• P°evod tvaru pro�lu do vektorové podoby

5.1.0.2 Nefunk£ní poºadavky

• Pouºití b¥ºn¥ dostupného hardware

• Vývoj softwaru v MFC C++

• Kompatibilita s formátem DXF

5.2 Pouºité nástroje a technologie

Vzhledem k poºadavku na °e²ení bez pouºití specializovaného hardwaru je volba vhod-

ného nástroje pro zachycení tvaru pro�lu zna£n¥ omezená. Jediné záznamové za°ízení,

které má tém¥° kaºdý k dispozici je fotoaparát. Proto padla volba primárního digita-

liza£ního nástroje práv¥ na n¥j. Jako alternativní moºnost byl zvolen digitální skener,

který rovn¥º dokáºe digitalizovat pro�l, ale musí být pro tuto funkci pat°i£n¥ upraven.
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V b¥ºném provedení m·ºe skener vytvá°et obtíºn¥ odstranitelné vady, proto byl zvolen

jako dopl¬ková moºnost a hlavní úsilí padlo na vyuºití fotoaparátu.

Aby bylo moºné pouºít pro digitalizaci b¥ºný digitální fotoaparát, který má spoustu

nedokonalostí a optických zkreslení, byla v aplikaci vyuºita open source knihovna pro

po£íta£ové vid¥ní OpenCV ve verzi 3.2.0, která umoº¬uje tyto nedostatky eliminovat.

Pro vývoj softwarové £ásti nástroje bylo vyuºito vývojové prost°edí Microsoft Visual

Studio 2012. Jako programovací jazyk byl podle poºadavk· zvolen C++ s knihovnou

MFC.

Pro tvorbu v²ech gra�ckých prvk· a ikon byly pouºity open source nástroje Gimp

2.8.18 a Inkscape 0.91.

Testování dosahované p°esnosti prob¥hlo s digitálním fotoaparátem Olympus OMD

EM-10 s objektivem M.ZUIKO 14-42mm f/3,5-5,6 a jako zástupce b¥ºné st°ední t°ídy

mobilních telefon· byl pouºit Huawei P9 lite, který obsahuje kameru s rozli²ením 13

Mpx s velikostí snímacího £ipu 1/3 palce a sv¥telností f/2.0. [20]

5.3 Kalibrace kamery

P°i pouºití digitálního fotoaparátu pro ú£ely po°izování p°esných snímk· je nejprve

nutné zbavit se optických vad, které se na snímcích mohou objevit a které znemoº-

¬ují zachycení skute£ných tvar· objekt·. K tomuto ú£elu jsou v knihovn¥ OpenCV

p°ipraveny funkce, které umoºní provést proces zvaný kalibrace kamery a následn¥ ze

získaných informací o optických vlastnostech fotoaparátu eliminovat radiální a tan-

genciální zkreslení. Teoretický popis optických vad fotoaparátu a princip kalibrace je

uveden v kapitole 3.

Samotná kalibrace spo£ívá v po°ízení série snímk· kalibra£ního obrazce. Snímky by

m¥ly být po°ízeny z r·zných úhl· a vzdáleností tak, aby byly získané údaje co nej-

p°esn¥j²í. Jako kalibra£ní obrazec je moºné pouºít kterýkoliv ze zmín¥ných obrazc·,

které jsou v knihovn¥ OpenCV k dispozici. Pro ú£ely vlastní aplikace byl zvolen jako

hlavní kalibra£ní obrazec asymetrická m°íºka kruhových bod·, protoºe dosahuje dob-

rých výsledk· i p°i malém po£tu snímk· (p°ibliºn¥ 15 - 20). Krom¥ ní je moºné pouºít

i ChArUco ²ablonu u které je ale nutné pro dosaºení stejné p°esnosti po°ídit mini-

máln¥ dvojnásobný po£et snímk·. Ve výsledku je jedno, která ²ablona byla pouºita

pro kalibraci, jelikoº jsou získané koe�cienty totoºné.

D·leºitým parametrem kalibrace je tzv. Reprojection error, který udává jak kvalitn¥

se poda°ilo kameru nakalibrovat. Vypo£ítá se jako druhá odmocnina ze st°ední kvad-

ratické odchylky mezi skute£nou a vypo£ítanou hodnotou bod· pro kaºdý kalibra£ní

snímek. V ideálním p°ípad¥ by tato hodnota m¥la být men²í neº 1.

Výstupem kalibrace je matice vnit°ních parametr· kamery (kapitola 3.1) a matice
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Obr. 5.1 P°íklad po°ízených kalibra£ních snímk·

koe�cient· zkreslení (kapitola 3.2). Tyto hodnoty jsou nem¥nné a proto sta£í pro kaºdou

kameru provést kalibraci pouze jednou. Jedinou nevýhodou jsou digitální fotoaparáty,

které umoº¬ují zm¥nu ohniska. U nich jsou tyto získané údaje vázány na konkrétní

hodnotu ohniskové vzdálenosti a proto je nutné bu¤ provést kalibraci pro r·zné oh-

niskové vzdálenosti, nebo pouºívat p°i focení pouze jedno nastavení. Tento problém

se nemusí °e²it u fotoaparát· ve v¥t²in¥ mobilních telefon·, jelikoº jejich kamery mají

�xní hodnotu ohniskové vzdálenosti.

5.4 Odstran¥ní radiálního zkreslení

Pomoci matic získaných p°i kalibraci kamery je moºné odstranit radiální zkreslení z

jakéhokoliv dal²ího snímku, který je daným fotoaparátem po°ízen. Postup opravy je

popsán v kapitole 3.2. Radiální zkreslení je nejvíce patrné na rovných liniích, které se

s rostoucí vzdáleností od st°edu ohýbají.

Na obrázku 5.2 je ukázka radiálního zkreslení p°ed a po korekci. Jedná se dv¥ kopie

téhoº snímku ²estnácti vodorovných, vzájemn¥ paralelních £ar, které jsou pro názornost

p°ekryty p°es sebe a obarveny. Modré £áry pat°í snímku p°ed korekcí, £ervené £áry pat°í

snímku po oprav¥ radiálního zkreslení. Z obrázku je rovn¥º patrná zv¥t²ující se míra

zak°ivení s rostoucí vzdáleností od optického st°edu.



UTB ve Zlín¥, Fakulta aplikované informatiky
	

41

Obr. 5.2 Radiální zkreslení p°ed korekcí (modré £áry) a po korekci (£ervené £áry)

5.5 Odstran¥ní vlivu perspektivy

Zbavit se radiálního a tangenciálního zkreslení je pom¥rn¥ snadné. Daleko v¥t²í pro-

blém je zkreslení perspektivy. Zásadním krokem v procesu digitalizace a m¥°ení pro�lu

je získat snímek jeho p°esného tvaru. Zkreslení perspektivy zp·sobí, ºe tvar pro�lu

na snímku je oproti skute£nému deformovaný a pro tento ú£el naprosto nevhodný.

Rozm¥ry pro�lu ze snímku také nelze zjistit. K tomu, aby bylo moºné se s tímto pro-

blémem vypo°ádat, musela by být známá vzdálenost a p°esná poloha foceného objektu

ke kame°e a ta zpravidla známá není a m¥°it ji ru£n¥ je prakticky nemoºné.

Aby bylo moºné tento zdánliv¥ ne°e²itelný problém vy°e²it, musí se do snímku umís-

tit objekt, jehoº rozm¥ry jsou p°edem známé. K tomuto ú£elu se výborn¥ hodí jiº zmí-

n¥né kalibra£ní obrazce, které jsou automaticky detekovatelné a obsahují body, jejichº

vzájemná vzdálenost je známá jak na snímku, tak ve skute£nosti.

Opravu perspektivy umoº¬uje v knihovn¥ OpenCV funkce WarpPerspective, která

provede warp obdélníku vyzna£eného na snímku £ty°mi rohovými body do kolmého

zobrazení s odpovídajícím pom¥rem stran. V²echny body na snímku, které tvo°í obdél-

ník jsou p°emapovány do pohledu shora a vliv perspektivy se tak vyru²í. Ukázka této
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funkce je na obrázku 5.3. Pokud se umístí dovnit° tohoto obdélníku p°edm¥t, který

má zanedbatelnou vý²ku (na p°íkladu jej reprezentuje nápis �Hello!�), dojde u n¥j rov-

n¥º k oprav¥ zkreslení perspektivy. Tento princip lze vyuºít i pro opravu perspektivy

vyfoceného pro�lu. Pokud se místo nápisu vloºí doprost°ed obdélníku u°íznutý plátek

pro�lu, dojde k oprav¥ perspektivy i u n¥j.

Obr. 5.3 Warp perspektivy pomoci £ty° bod· [21]

Na zmín¥ném p°íkladu na obrázku 5.3 je nutné vyzna£it rohy obdélníku ru£n¥. To

ale neplatí v p°ípad¥ pouºití n¥kterého z kalibra£ních obrazc·, které knihovna OpenCV

umí automaticky na snímku najít a zjistit z n¥j sou°adnice v²ech detekovaných bod·. Z

t¥chto bod· lze snadno ur£it £ty°i rohové a pouºít je jako vstupní parametr do funkce

pro warp perspektivy.

5.5.1 Úprava kalibra£ního obrazce

Standardní kalibra£ní obrazce, jako je ²achovnice, nebo m°íºka kruhových bod· mají

jednu velkou nevýhodu. Aby je bylo moºné správn¥ detekovat a ur£it rohové body,

musí být na snímku viditelné celé. Cílem ale není opravit pouze perspektivu obrazce,

ale p°edev²ím p°edm¥tu, který je na n¥m umíst¥n. Pokud se na kalibra£ní obrazec

poloºí n¥jaký p°edm¥t, zp·sobí jeho £áste£né p°ekrytí a znemoºní tak jeho správnou

detekci a tím i celý warp perspektivy.

Zmín¥ný problém zdárn¥ °e²í obrazce z ArUco modulu, které p°i°azují kaºdému bodu

jedine£ný identi�kátor a v p°ípad¥ p°ekrytí n¥kterého bodu umoºní jeho dopo£ítání ze

sousedních bod· (popis ArUco moulu je uveden v kapitole 3.4.1). Umíst¥ní p°edm¥tu

na ArUco ²ablonu tak neznemoºní detekování rohových bod· a tak nic nebrání tomu

vyuºít je na automatický warp perspektivy. Pro ú£ely této aplikace byla zvolena ²ablona

ChArUco, která je roz²í°ením ²ablony ArUco a dosahuje v¥t²í p°esnosti.
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�ablona ChArUco spojuje klasický ²achovnicový vzor a ArUco kódy. P·vodn¥ byl

²achovnicový vzor ur£en pro celkovou detekci polohy obrazce na snímku. V p°ípad¥

ChArUco ²ablony slouºí pouze pro dodate£né zp°esn¥ní polohy, ke kterému se vyuºívají

spole£né rohy ²achovnicových £tverc·. P°ibliºný postup detekce je popsán v kapitole

3.4.1. Problémem t¥chto £tverc· je jejich velká plocha, která v p°ípad¥ tisku ²ablony na

papír spot°ebuje velké mnoºství barvy. Jelikoº se z kaºdého £erného £tverce vyuºijí p°i

detekci pouze jeho rohy, bylo moºné £erné £tverce z ²ablony odstranit a nahradit kaºdý

z nich £ty°mi men²ími £tverci reprezentujícími pouze jejich rohy. Schopnosti detekce tak

z·staly nezm¥n¥ny a barevná plocha ²ablony se zna£n¥ zmen²ila. Porovnání p·vodního

vzoru ²ablony a upraveného je na obrázku 5.4. Na první pohled je patrná velká úspora

barvy p°i tisku ²ablony. Tato upravená ²ablona je dále nazývána jako korek£ní ²ablona.

Obr. 5.4 P·vodní vzor (vlevo) a upravený vzor (vpravo)

Rozm¥ry celé ²ablony se vztahují k p·vodnímu ²achovnicovému vzoru a jsou tedy

ur£eny po£tem £tverc· ²achovnice na ²í°ku a na vý²ku. Pro ú£ely m¥°ení pro�l· byl

zvolen rozm¥r ²ablony 16 £tverc· na ²í°ku a 10 na vý²ku. D·vodem je p°edpokládaný

tisk ²ablony na papír standardních rozm¥r·.

Rozm¥ry jednotlivých £ástí ²ablony jsou zvoleny pouze pom¥rov¥ a jejich fyzická

velikost se ur£í aº p°i samotném tisku ²ablony. Základní rozm¥r je ur£en p·vodním

²achovnicovým vzorem a strana jednoho polí£ka ²achovnice má tedy velikost 1. Po

upravení a nahrazení ²achovnicového vzoru rohovými £tverci se tento základní rozm¥r

vztahuje na vzdálenost vn¥j²ích stran dvou malých £tverc·, které p·vodn¥ tvo°ily jedno

polí£ko. Velikost strany £tverce tvo°ícího 2D kód je 0,7 a velikost jednoho malého £tverce

uvnit° 2D kódu je 0,1. V²echny rozm¥ry jsou zobrazeny na obrázku 5.5.

�ablona obsahuje celkem 80 2D ArUco kód·. Jednotlivé kódy jsou tvo°eny m°íº-

kou 5×5 £tverc·, které jsou bu¤ bílé, nebo £erné. Na základ¥ jejich barvy je moºné
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Obr. 5.5 Pom¥ry velkostí jednotlivých
£ástí obrazce

ur£it jedine£ný identi�kátor kódu. V²echny kódy byly vygenerovány pomocí knihovny

OpenCV tak, aby jejich vzájemná Hammingova vzdálenost byla co nejv¥t²í. Díky tomu

je moºné pouºít opravné mechanismy p°i nesprávné detekci kódu na snímku. Je tak

moºné opravit 2 chybn¥ detekované £tvere£ky v kaºdém kódu. Pouºitý slovník obsa-

huje celkem 250 unikátních kód·. D·vodem pouºití v¥t²ího slovníku je p°ípadné dal²í

roz²í°ení ²ablon a zachování zp¥tné kompatibility.

Obr. 5.6 Výsledná ²ablona

Na obrázku 5.6 je �nální podoba upravené ChArUco ²ablony. Jelikoº jsou rozm¥ry

²ablony ur£eny pouze pom¥rov¥, je pot°eba zjistit pro pozd¥j²í pouºití i její skute£né

fyzické rozm¥ry. Pro snadné zm¥°ení obsahuje ²ablona ve své spodní £ásti dva £erné
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pruhy. Vzdálenost vn¥j²ích hran t¥chto pruh· je p°esn¥ 14,25 násobek rozm¥ru základ-

ního £tverce.

5.6 Korekce vý²ky

Korekce perspektivy pomocí obdélníkové ²ablony se známým pom¥rem stran je po-

m¥rn¥ p°esná. Má ale jeden velký nedostatek. Oprava perspektivy se provede pouze

v rovin¥ ²ablony. Aby bylo moºné opravit perspektivu i u p°edm¥tu poloºeného na

této ²ablon¥, musel by leºet ve stejné rovin¥, jako ²ablona. Jinak °e£eno, musel by mít

nulovou vý²ku. V praxi je ale nereálné u°íznout pro�l tak tenký, ºe by jeho vý²ka byla

zanedbatelná a je tedy pot°eba provést korekci perspektivy s ohledem na skute£nou

vý²ku pro�lu. Bez této korekce by bylo moºné m¥°it pro�l pouze na úrovni ²ablony, ale

v této rovin¥ je v¥t²ina plochy pro�lu zakrytá.

K tomuto ú£elu bylo vyuºito moºností knihovny OpenCV a jejího modulu ArUco

pro roz²í°enou realitu. Principem roz²í°ené reality je p°idání n¥jakého po£íta£em vy-

tvo°eného objektu do snímku a vytvo°ení tak pr·niku reálného a virtuálního sv¥ta.

Modul ArUco se zam¥°uje na vykreslování 3D objekt· a k tomu pot°ebuje ur£it v

obraze lokální sou°adnicový systém. Pro tento ú£el slouºí jiº zmín¥né ²ablony ArUco

a ChArUco, které obsahují unikátní detekovatelné body. Na základ¥ vzájemné polohy

t¥chto bod· a ze znalosti pozice celé ²ablony ke kame°e se odhadne lokální sou°adný

systém ²ablony, jehoº Z sou°adnice je k ²ablon¥ kolmá v kaºdém jejím bod¥. Do to-

hoto sou°adného systému se následn¥ vykreslují poºadované objekty v rámci roz²í°ené

reality.

Tento princip je ale moºné pouºít i jiným zp·sobem. Místo p°idávání digitálních

objekt· do obrazu je moºné vyuºít znalost lokálního sou°adnicového systému k od-

hadu relativní polohy skute£ného p°edm¥tu ku ²ablon¥. Pokud se na ChArUco ²ablonu

umístí nap°íklad krychle, pak jsou její svislé hrany paralelní se Z sou°adnicí ²ablony.

Pokud by byla známá skute£ná velikost ²ablony a délka strany krychle, bylo by moºné

vykreslit do obrazu p°esn¥ stejnou krychli, jaká se tam ve skute£nosti nachází. Cílem

ale není vykreslovat do obrazu dal²í objekty. Hlavním zám¥rem je opravit perspektivu

p°edm¥tu, který je na ²ablon¥ poloºen.

Vyuºitím znalosti sou°adnicového systému ²ablony je moºné virtuáln¥ posunout ce-

lou ²ablonu do stejné vý²ky, jakou má objekt, který se na ní nachází. Jinými slovy

zm¥nit Z sou°adnici v²ech bod· ²ablony na p°edem zm¥°enou vý²ku u°ezaného pro�lu.

Následn¥ se tyto posunuté body transformují zp¥t do snímku a vnikne tak nová rovina,

která se nachází p°esn¥ ve vý²ce pro�lu. V této nové rovin¥ se ur£í body obdélníku, ve

kterém se nachází pro�l a provede se warp perspektivy stejným zp·sobem, jako s ob-

délníkem de�novaným £ty°mi rohy ²ablony. Perspektiva se tak opraví v rovin¥, ve které
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se nachází £elo pro�lu a ve které se jako jediné dají m¥°it v²echny pot°ebné rozm¥ry.

5.7 Aplikace korekcí a m¥°ení rozm¥r·

Aby bylo moºné m¥°it vytla£ovaný pro�l na snímku po°ízeném fotoaparátem, musí se

postupn¥ provést v²echny korekce popsané v p°edchozích kapitolách 5.4, 5.5 a 5.6. Celý

proces za£íná kalibrací kamery (kapitola 5.3). Jakmile je kamera správn¥ nakalibrovaná,

m·ºe se po°ídit snímek poºadovaného pro�lu umíst¥ného na upravené ChArUco ²ablon¥

(obrázek 5.7). Na tento snímek se aplikují korekce radiálního a tangenciálního zkreslení

podle koe�cient· získaných z kalibrace.

Obr. 5.7 Snímek pro�lu

Následující kroky uº jsou pln¥ automatické a nevyºadují ºádnou akci ze strany uºiva-

tele. Nejprve se detekují ArUco kódy (obrázek 8.3). Tento krok slouºí pro hrubý odhad

polohy ²ablony na snímku. V²echny správn¥ detekované kódy jsou zelen¥ ohrani£eny. Z

obrázku je patrné, ºe kódy, které jsou zakryté pro�lem detekovány nebyly. Minimální

po£et správn¥ detekovaných kód· není ur£en. D·leºité je, aby se nacházely rovnom¥rn¥

okolo celého pro�lu. Je proto nutné zvolit velikost ²ablony p°im¥°en¥ k velikosti pro�lu.
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Obr. 5.8 Detekce 2D kód·

Dal²ím krokem je detekce roh· ²achovnice, respektive pr·se£ík· malých £tverc·,

které je v upravené ²ablon¥ nahradily. Kaºdý roh je ur£en dv¥ma diagonáln¥ sousedícími

kódy. Popis detekce je v kapitole 3.4.1. Na obrázku 5.9 jsou detekované rohy znázorn¥ny

£ervenými te£kami. Kaºdý bod má zárove¬ p°i°azeno jedine£né ID, které se ur£í na

základ¥ sousedních kód·. V dal²ích krocích se vyuºijí uº jen tyto p°esné body.

Z takto získané m°íºky bod· se následn¥ vytvo°í 3D sou°adný prostor. Jeho vizua-

lizace je na obrázku 5.10. �ervené svislé £áry vycházejí z pozic rohových bod· a jsou

k ²ablon¥ kolmé. Z obrázku je patrné, ºe £áry vychází i z bod·, které byly v zákrytu a

nemohly být detekovány p°ímo. Jejich poloha je dopo£ítána díky znalosti pozice ostat-

ních bod·. Stejným zp·sobem lze vypo£ítat polohu libovolného bodu v této 3D m°íºce.

Svislé £áry rovn¥º dokazují správnost této metody. Na obrázku je moºné porovnat, ºe

jsou s kolmými st¥nami pro�lu paralelní.

Následujícím krokem je oprava perspektivy. Aby mohla být perspektiva správn¥

opravena, musí být známá vý²ka pro�lu. Je to jediný rozm¥r, který musí být pro kaºdý

pro�l ru£n¥ zm¥°en. Údaj o vý²ce poslouºí jako hodnota Z sou°adnice, do které se

posunou v²echny body m°íºky. Na obrázku 5.10 je tato rovina znázorn¥na zelenou

m°íºkou. Následn¥ se v této posunuté m°íºce ur£í 4 rohové body a provede se 4 bodový
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Obr. 5.9 Detekce roh· p·vodní ²achovnice

warp perspektivy.

Na obrázku 5.11 je výsledek v²ech korek£ních úprav. Na první pohled se m·ºe opra-

vený snímek stále jevit jako zkreslený, ale je to pouze optický klam. Oprava perspektivy

prob¥hla pouze ve vrstv¥, ve které se nachází horní strana pro�lu. V²echno ostatní, co

se na snímku nachází v jiné vrstv¥ nad ²ablonou, v£etn¥ ²ablony samotné je zobrazeno

²patn¥. Jediná £ást snímku, která je vyobrazena z hlediska perspektivy správn¥ je horní

strana pro�lu.

Posledním krokem je získání m¥°ítka snímku, aby bylo moºné m¥°it v²echny poºado-

vané rozm¥ry. K tomu sta£í znát pouze velikost, respektive ²í°ku ²ablony v milimetrech,

zm¥°enou mezi dv¥ma vyzna£enými m¥°ícími body. Z této hodnoty lze jednoduchým

pod¥lením £íslem 14,25 vypo£ítat velikost jednoho £tverce ²ablony. Nyní sta£í vzít ²í°ku

upraveného obrázku v pixelech, pod¥lit ji po£tem £tverc· ²ablony a nakonec je²t¥ po-

d¥lit skute£nými rozm¥ry jednoho £tverce. Vznikne tak koe�cient, jehoº jednotka je

pixel na milimetr. Následn¥ je moºné zm¥°it na snímku libovolný rozm¥r horní strany

pro�lu v pixelech a jednoduchým p°epo£tem ur£it jeho reálnou velikost v milimetrech.
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Obr. 5.10 Vytvo°ení 3D m°íºky

Obr. 5.11 Provedení warpu perspektivy
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6 Pro�le Digitizer

Na základ¥ algoritm· popsaných v p°edchozí kapitole vznikla aplikace Pro�le Digitizer.

Jedná se o samostatnou, pln¥ funk£ní aplikaci pro opera£ní systém Microsoft Windows

10, která spl¬uje v²echny zadané poºadavky.

Aplikace Pro�le Digitizer je navrºena tak, aby umoº¬ovala rychlé a snadné m¥°ení

rozm¥r· pro�l·, srovnání jejich skute£ného tvaru s výkresem a p°evod do vektorové

podoby, se kterou umí pracovat r·zné CAD programy.

6.1 Kreslící plátno

Základ aplikace tvo°í kreslící plátno, postavené na gra�ckém rozhraní GDI+. Ve²keré

operace m¥°ení, srovnávání a digitalizace probíhají práv¥ na tomto plátn¥. Základní

vrstvu plátna tvo°í fotogra�e pro�lu. Ostatní objekty se malují vºdy nad tuto vrstvu.

Kreslící plátno slouºí zárove¬ jako nástroj pro zobrazování a kreslení kubických Bézie-

rovych k°ivek a rovných £ar.

Bézierovy k°ivky jsou vyuºity jak pro vyzna£ení tvaru pro�lu, tak pro vykreslení

poºadovaného tvaru pro optické srovnání s fotogra�í. Pouºití pouze kubických Bézie-

rových k°ivek je výhodné z hlediska vykreslování a archivace dat. Lze s nimi jednodu²e

popsat tém¥° libovolný tvar a p°itom jsou de�novány pouze £ty°mi body. Po£áte£ním,

koncovým a dv¥ma °ídícími. Rovné £áry jsou rovn¥º tvo°eny Bézierovými k°ivkami. Ty

mají °ídící body shodné s po£áte£ním a koncovým bodem. Díky tomu je moºné jed-

nodu²e vytvo°it z rovné £áry k°ivku a naopak bez nutnosti m¥nit typ vykreslovaného

objektu.

6.2 Práce s daty

Aplikace Pro�le Digitizer musí vzhledem ke svému zam¥°ení zvládat práci s r·znými

typy soubor·. Pro zpracování fotogra�í musí podporovat nejpouºívan¥j²í gra�cké for-

máty. Aby bylo moºné porovnat poºadovaný tvar pro�lu a export geometrie vyfoceného

pro�lu, musí um¥t pracovat s CAD formátem DXF. V poslední °ad¥ musí umoº¬ovat

ukládání vlastních projekt· z d·vodu archivace a moºnosti vrátit se k práci pozd¥ji.

6.2.1 Snímky

Po°ízené digitální snímky je moºné do aplikace importovat ve v²ech formátech, které

jsou podporovány gra�ckým rozhraním GDI+. Jmenovit¥ jsou to BMP, GIF, PNG,

JPEG a TIFF. V t¥chto formátech lze rovn¥º snímek exportovat. Ostatní formáty,

které dokáºe GDI+ zpracovat (WMF, EMF, ...) je moºné rovn¥º importovat. Jejich

pouºití se ale v rámci této aplikace nep°edpokládá. [22]
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6.2.2 Formát DXF

DXF je vektorový gra�cký formát vytvo°ený �rmou AutoCAD. Je to jeden z nejzáklad-

n¥j²ích formát· pro p°enos soubor· mezi CAD aplikacemi. Krom¥ ²irokého roz²í°ení je

jeho velkou výhodou strukturovaný ASCII zápis vektorových objekt·, který je snadno

£itelný i pro £lov¥ka. Existuje i binární varianta formátu DXF, ta ale není tolik roz²í-

°ena a práce s ní je náro£n¥j²í. V aplikaci Pro�le Digitizer je implementována ASCII

varianta, která slouºí pro import poºadovaného tvaru pro�lu a pro export obrysu vy-

foceného pro�lu. [23]

Formát DXF podporuje velké mnoºství entit a jejich vlastností. V aplikaci Pro�le

Digitizer jsou implementovány pouze n¥které základní entity.

Obecný textový soubor DXF obsahuje osm sekcí. Kaºdá sekce za£íná svým identi-

�kátorem a kon£í zna£kou konce oblasti. N¥které sekce jsou nepovinné a nemusí být v

souboru obsaºeny. Podrobný výpis jednotlivých sekcí je v tabulce 6.1

Tab. 6.1 Popis sekcí v DXF souboru [23]

Název
sekce

Význam

HEADER Hlavi£ka souboru, která obsahuje informace o výkresu a
programu, který jej vytvá°el.

CLASSES Informace o t°ídách vytvo°ených v CAD programu.
TABLES Styly pro vykreslení, nastavení písem, pohled·, kótování

a dal²í.

BLOCKS Bloky, které slu£ují entity pod jeden identi�kátor.

ENTITIES Výpis jednotlivých gra�ckých entit a blok·.

OBJECTS Informace o negra�ckých entitách.

EOF Konec souboru.

Do jednotlivých sekcí se dále zapisují skupiny, které jsou tvo°eny vºdy dv¥ma °ádky.

Na prvním z t¥chto °ádku je £íselný kód skupiny a na druhém °ádku p°íslu²ná hodnota.

Ta m·ºe být bu¤ textová, nebo £íselná. Vazba mezi kódem skupiny a typem hodnoty

je vypsána v tabulce 6.2. [23]

Aplikace Pro�le Digitizer vyºaduje pouze sekci ENTITIES a umí importovat entity

typu POLYLINE, LINE, ARC a CIRCLE. Ostatní sekce a entity jsou ignorovány. Pro

export dat vyuºívá pouze univerzální entity typu POLYLINE. Podporované kódy pro

jednotlivé entity jsou uvedeny v a tabulkách 6.3, 6.4, 6.5. Entita POLYLINE má pouze

jeden podporovaný parametr a to je vrchol (VERTEX, tabulka 6.6). T¥chto vrchol·

m·ºe obsahovat libovolné mnoºství. Úhel, který de�nuje zak°ivení poly£áry je ur£en
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Tab. 6.2 Rozsahy skupin a p°íslu²né datové typy v DXF [23]

Rozsah kódu skupin Typ uloºených údaj·

0�9 °et¥zce

10�59 reálná £ísla

60�79 celá £ísla

140�147 reálná £ísla

170�175 celá £ísla

210�239 reálná £ísla

999 °et¥zec (komentá°)

1000�1009 °et¥zce

1010�1059 reálná £ísla

1060�1079 celá £ísla

pro kaºdý segment jeho vrcholem a je vypo£ítán jako tangent 1/4 vloºeného úhlu mezi

aktuálním a následujícím vrcholem.

Tab. 6.3 Entita LINE

Kód skupiny Hodnota

10 X sou°adnice po£áte£ního bodu

20 Y sou°adnice po£áte£ního bodu

11 X sou°adnice koncového bodu

21 Y sou°adnice koncového bodu

Tab. 6.4 Entita ARC

Kód skupiny Hodnota

10 X sou°adnice st°edového bodu

20 Y sou°adnice st°edového bodu

40 polom¥r

50 po£áte£ní úhel

51 koncový úhel
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Tab. 6.5 Entita CIRCLE

Kód skupiny Hodnota

10 X sou°adnice st°edového bodu

20 Y sou°adnice st°edového bodu

40 polom¥r

Tab. 6.6 Entita VERTEX

Kód skupiny Hodnota

10 X sou°adnice vrcholu

20 Y sou°adnice vrcholu

42 úhel ur£ující zak°ivení segmentu

6.2.3 Archivace ve formátu XML

Kaºdá rozsáhlej²í aplikace, která umoº¬uje zpracovávat data by m¥la um¥t uloºit sv·j

aktuální stav a znovu jej na£íst. Tato funkce je nesmírn¥ d·leºitá z hlediska archivace

projektu, jeho p°ená²ení, posílání elektronickou cestou, nebo pro moºnost vrátit se k

rozpracovanému projektu pozd¥ji.

Aplikace Pro�le Digitizer p°i práci vyuºívá n¥kolik r·zných typ· dat. V prvé °ad¥ je

to obrázek, respektive po°ízená fotogra�e, dále jsou to r·zné £íselné informace nap°í-

klad o rozli²ení snímku v milimetrech a nakonec vektorová data popisující tvar pro�lu.

Aby se celý projekt snáze p°ená²el, musí být v²echny vyjmenované sou£ásti uloºeny

do jednoho souboru. Existuje spousta moºností, jak toho dosáhnout, nap°íklad pouºít

serializaci a vytvo°it ze v²ech dat jeden binární soubor. Takovýto binární soubor má

ale spoustu nevýhod. Je moºné jej zpracovat pouze v rámci dané aplikace, obtíºn¥ se

dodrºuje zp¥tná kompatibilita p°i roz²i°ování funkcí a není jej moºné ru£n¥ prohlíºet

a editovat. Druhou moºností je pouºít textový soubor. Ten má hlavní výhodu v tom,

ºe jej lze jednodu²e prohlíºet a upravovat. Navíc pokud se pouºije p°esn¥ de�novaný

strukturovaný zápis, nap°íklad zna£kovací jazyk XML, je moºné vytvo°it soubor jed-

nodu²e £itelný jak pro aplikaci, tak pro £lov¥ka. Jeho nejv¥t²í výhoda je ale zárove¬

jeho nejv¥t²í nevýhodou. Umoº¬uje zápis pouze textových hodnot. V p°ípad¥, kdy je

pot°eba uloºit i binární data (obrázek) musí být nejprve p°evedena do textové podoby

a tím zna£n¥ naroste velikost souboru.

I p°es nutnost ukládat obrázek byl pro ukládání projektu v aplikaci Pro�le Digiti-

zer zvolen textový formát s XML strukturou. Výhody ru£ní editace a prohlíºení dat

zvít¥zily nad uzav°eným binárním souborem.
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Aby bylo moºné obrázek uloºit do textového souboru, musí být p°eveden do tex-

tové podoby. Jednou z moºností, jak toho dosáhnout je uloºit hodnoty RGB sloºek pro

kaºdý pixel obrázku v hexadecimálním tvaru. Kaºdý obrazový bod by tak zabíral 9

znak·. Na první pohled je jasné, ºe pro velké obrázky, které produkují sou£asné digi-

tální fotoaparáty by byl soubor nesmysln¥ velký a jakákoliv manipulace s ním by byla

obtíºná. Druhou moºností je nechat obrázek tak jak je a p°evést celou jeho binární

reprezentaci do textové podoby. V tomto p°ípad¥ dojde pouze k £áste£nému navý²ení

velikosti souboru, které je oproti prvnímu p°ípadu v mnohem snesiteln¥j²ích mezích.

Pro aplikaci Pro�le Digitizer byla zvolena druhá moºnost, p°i£emº obrázek jako takový

je pro je²t¥ výrazn¥j²í úsporu místa p°eveden do formátu JPEG nezávisle na tom, v

jakém formátu byl p·vodn¥ importován.

Tab. 6.7 P°evodní tabulka kódování Base64 [24]

Hodnota ASCII
znak

Hodnota ASCII
znak

Hodnota ASCII
znak

Hodnota ASCII
znak

0 A 17 R 34 i 51 z

1 B 18 S 35 j 52 0

2 C 19 T 36 k 53 1

3 D 20 U 37 l 54 2

4 E 21 V 38 m 55 3

5 F 22 W 39 n 56 4

6 G 23 X 40 o 57 5

7 H 24 Y 41 p 58 6

8 I 25 Z 42 q 59 7

9 J 26 a 43 r 60 8

10 K 27 b 44 s 61 9

11 L 28 c 45 t 62 +

12 M 29 d 46 u 63 /

13 N 30 e 47 v

14 O 31 f 48 w

15 P 32 g 49 x

16 Q 33 h 50 y

Pro p°evod obrázku do textové podoby je pouºito kódování Base64. Toto kódování

umoº¬uje p°evést binární data uspo°ádaná do oktet· na 64 tisknutelných znak· z

ASCII znakové sady. Pro p°evod není podstatný obsah ani formát dat, jelikoº se p°evádí

p°ímo jejich binární reprezentace. Samotný p°evod probíhá v n¥kolika krocích. Nejprve

se binární soubor rozd¥lí na skupiny po 3 osmibitových hodnotách. Kaºdá tato skupina
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je poté p°evedena na 4 ²estibitová £ísla. Kaºdé ²estibitové £íslo je tedy v rozsahu 0�6310.

Následn¥ sta£í tato £ísla vzít a podle p°ekladového slovníku je p°evést na odpovídající

tisknutelný znak. P°evod z Base64 kódování zp¥t do binární podoby se provádí opa£ným

postupem. P°ekladový slovník je uveden v tabulce 6.7. [24]

Po p°evedení obrázku do kódování Base64 jsou jiº v²echna pot°ebná data pro popis

aktuálního stavu aplikace v textové podob¥ a mohou být uloºena v jediném textovém

souboru s XML strukturou. Stromová struktura je znázorn¥na na obrázku 6.1.

Obr. 6.1 Struktura XML souboru pro uloºení projektu

Ko°enový adresá° obsahuje dva základní objekty. Obrázek pro�lu IMAGE a vek-

torový tvar pro�lu SHAPE. Obrázek se nachází v XML souboru vºdy pouze jeden.

Obsahuje údaj o svém rozli²ení v milimetrech na pixel PXPMM a binární data v kó-

dování Base64. Ta jsou uloºena v °et¥zcích po 128 znacích mezi tagy DATA.

Element· SHAPE se m·ºe v souboru nacházet více. Kaºdý SHAPE tvo°í jednu

nep°eru²enou stopu sloºenou z Bézierovych k°ivek. Element SIZE udává, z kolika k°ivek

se skládá a element CLOSED ur£uje, jestli je k°ivka uzav°ená a jestli má být poslední
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bod poslední k°ivky spojen s první bodem první k°ivky.

Jednotlivé Bézierovy k°ivky se dále skládají ze svých £ty° de�ni£ních bod· P1,

P2, C1, C2 a jejich X a Y sou°adnic. Dal²í dva elementy pojmenované jako JO-

INED_WITH_PREV a JOINED_WITH_NEXT ur£ují chování °ídících bod·, re-

spektive ur£ují, jestli jsou °ídící body spojeny s °ídícími body sousední k°ivky. Toto

spojení se projevuje p°edev²ím p°i editaci k°ivky, kdy zm¥nou polohy °ídícího bodu

k°ivky dojde zárove¬ k opa£né zm¥n¥ polohy p°ilehlého °ídícího bodu sousední k°ivky.
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7 Ovládání aplikace

Aplikace Pro�le Digitizer byla navrºena s ohledem na co nejjednodu²²í ovládání. V²echny

d·leºité funkce jsou dostupné z nástrojové li²ty a ve²keré operace m¥°ení a digitalizace

pro�lu je moºné provést pouze pomocí my²i. Základní okno aplikace je na obrázku 7.1.

Obr. 7.1 Základní okno aplikace

Na obrázku 7.1 je zobrazena nástrojová li²ta, jejíº popis je v seznamu níºe.

Obr. 7.2 Nástrojová li²ta

1. Vytvo°ení nového projektu

2. Otev°ení uloºeného projektu

3. Uloºení aktuálního projektu

4. Export obrysu pro�lu jako DXF
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5. Import poºadovaného tvaru pro�lu ve formátu DXF

6. Vrátit akci zp¥t

7. Znovu provést akci

8. P°epína£ editace pro�lu

9. P°epína£ editace poºadovaného tvaru

10. Kreslení Bézierových k°ivek

11. Pravítko pro m¥°ení rozm¥r·

12. Úhlom¥r pro m¥°ení úhl·

13. Zobrazení/skrytí podkladové fotogra�e

14. Zobrazení/skrytí nakreslených k°ivek

15. Zobrazení/skrytí poºadovaného tvaru

16. Zoom na v²e

7.1 Kalibrace kamery

Aby bylo moºné aplikaci Pro�le Digitizer plnohodnotn¥ pouºívat, musí se nejprve na-

kalibrovat alespo¬ jeden fotoaparát. Kalibrace se nachází v menu Settings→Camera

Calibration, nebo ji lze spustit p°i zakládání nového projektu.

Dialog pro kalibraci je zobrazen na obrázku 7.3. Na výb¥r je ze dvou kalibra£ních

obrazc·: CIRCLES GRID (asymterická m°íºka kruhových bod·) a CHESSBOARD

(ChArUco ²ablona). Z rolovacího menu (bod 1) se nejprve musí zvolit, která ²ablona

se má pro kalibraci pouºít. P°ednastavená volba je CIRCLES GRID, která je pro

kalibraci vhodn¥j²í. Druhá ²ablona (CHESSBOARD) nedosahuje takové p°esnosti a

je zde pouze pro p°ípad, kdy je pot°eba provést kalibraci pomocí vytisknuté korek£ní

ChArUco ²ablony.

Vybranou kalibra£ní ²ablonu je moºné zobrazit na monitoru klepnutím na tla£ítko

Show (bod 2). �ablona se zobrazí p°es celou plochu obrazovky tak, aby ji bylo moºné

jednodu²e vyfotit. Je pot°eba po°ídit alespo¬ 15 fotogra�í p°i pouºití ²ablony CIRCLES

GRID. Pro CHESSBOARD je t°eba alespo¬ 30 fotek. Snímky ²ablony musí být po°í-

zeny z r·zných úhl· a vzdálenosti. Ukázka po°ízených snímk· ²ablony je v kapitole o

kalibraci na obrázku 5.1. �ablonu je moºné zav°ít stisknutím klávesy Esc.

Snímky ²ablony je poté pot°eba nahrát do aplikace klepnutím na tla£ítko Load

Images (bod 3) a zvolením jejich umíst¥ní. V²echny nahrané snímky se poté vypí²í



UTB ve Zlín¥, Fakulta aplikované informatiky
	

59

Obr. 7.3 Okno kalibrace kamery

do seznamu snímk· (bod 4). Samotný proces kalibrace se zahájí tla£ítkem Calibrate

(bod 5).

Proces kalibrace zabere n¥kolik vte°in aº jednotek minut v závislosti na po£tu

snímk·, jejich rozli²ení, pouºité ²ablon¥ a výkonu po£íta£e. Kalibraci je moºné sle-

dovat v okn¥ (bod 6), kde se v p°ípad¥ správ¥ detekovaného snímku vykreslí barevné

£áry propojující st°edy detekovaných bod·. Celkový pr·b¥h kalibrace je znázorn¥n na

ukazateli pr·b¥hu (bod 7). Pod ukazatelem jsou vypsány aktuální informace o po£tu

detekovaných a nedetekovaných snímk· (bod 8 a 9).

Obr. 7.4 Oznámení o
dokon£ení kalibrace

Po dokon£ení kalibrace se zobrazí okno oznamující celkový po£et detekovaných
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snímk· a chybu zp¥tné projekce (Re-projection error). Zobrazena je i v okn¥ aplikace

(bod 10). Tato chyba by nem¥la být v¥t²í neº 1.

Následn¥ je pot°eba zvolit název (bod 11) a kalibra£ní údaje uloºit klepnutím na

tla£ítko Save (bod 12). V²echny nakalibrované kamery se zobrazují v seznamu kamer

(bod 13), odkud je moºné je smazat pomocí tla£ítka Delete (bod 14).

7.2 Nastavení korek£ní ²ablony

Druhý krok, který je nutné provést, aby bylo moºné aplikaci plnohodnotn¥ pouºívat

je nastavení rozm¥r· korek£ních ²ablon. Aplikace jiº obsahuje n¥kolik p°ednastavených

rozm¥r· ²ablon, které jsou dodávány spolu s programem v papírové form¥, nebo jako

PDF dokument p°ipravený k vytisknutí. V p°ípad¥ pouºití dodaných ²ablon je moºné

celý tento krok p°esko£it. V p°ípad¥ tisku vlastního rozm¥ru ²ablony je pot°eba zare-

gistrovat její rozm¥r v aplikaci. Dialog pro nastavení ²ablony je moºné otev°ít z menu

Settings→Board, nebo p°i vytvá°ení nového projektu. Tento dialog je zobrazen na ob-

rázku 7.5.

Obr. 7.5 P°idání nového rozm¥ru ²ablony

P°i registraci ²ablony je pot°eba zm¥°it její rozm¥r. Ten se m¥°í pomocí dvou zna£ek
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na spodní stran¥ ²ablony. Zp·sob m¥°ení je znázorn¥n na obrázku ²ablony (bod 1).

Zm¥°ený rozm¥r se následn¥ zadá do polí£ka Width (bod 2) a zvolí se jméno, pod

kterým se bude ²ablona pouºívat (bod 3). Pomocí tla£ítka Add se rozm¥r uloºí a objeví

se v seznamu ²ablon (bod 4). Z toho seznamu je moºné zaregistrované ²ablony mazat

pomocí tla£ítka Delete.

7.3 Vytvo°ení nového projektu

Po úsp¥²né kalibraci fotoaparátu a zaregistrování rozm¥ru ²ablony je moºné za£ít sa-

motnou digitalizaci pro�l·.

7.3.1 P°íprava pro�lu

Prvním krokem je p°íprava pro�lu pro focení. Z poºadovaného pro�lu se kolmo na

sm¥r vytla£ování u°ízne tenký plátek. Jeho tlou²´ka není p°ímo omezena, ale nem¥la

by p°esáhnout 5cm. �ím ten£í plátek je moºné u°ezat, tím p°esn¥j²ích výsledk· je

moºno dosáhnout. �ez musí být proveden rovn¥ a hrany pro�lu musí z·stat ostré.

7.3.2 Vyfocení pro�lu

U°ezaný plátek se následn¥ vloºí doprost°ed korek£ní ²ablony. Velikost ²ablony se volí

p°im¥°en¥ k velikosti pro�lu tak, bylo na snímku okolo pro�lu dostate£né mnoºství

viditelných kód·. Následn¥ se po°ídí pomocí nakalibrovaného fotoaparátu snímek ²ab-

lony s pro�lem. Snímek by nem¥l být po°ízen p°esn¥ kolmo na ²ablonu, ale z mírného

úhlu. Ukázka správn¥ vyfoceného pro�lu je na obrázku 5.7.

7.3.3 Zpracování snímku v aplikaci

Pro zpracování snímku je pot°eba zaloºit v aplikaci Pro�le Digitizer nový projekt

klepnutím na p°íslu²nou ikonu, nebo volbou v menu File→New Project. Tímto se otev°e

dialog s nastavením projektu (obrázek 7.6). V tomto dialogu je pot°eba zvolit cestu k

fotogra�i pro�lu (tla£ítko Open Image). Dále je t°eba zvolit, jestli byl snímek po°ízen fo-

toaparátem, nebo skenerem. V p°ípad¥ skeneru se ºádné obrazové korekce neprovád¥jí.

Do polí£ka Pro�le Height je t°eba doplnit vý²ku pro�lu (respektive tlou²´ku u°ezaného

plátku) v milimetrech. Dále je t°eba zvolit uloºenou kalibraci pouºitého fotoaparátu a

velikost korek£ní ²ablony, na které byl pro�l vyfotografován. Po vypln¥ní v²ech t¥chto

poºadovaných údaj· se stiskem tla£ítka OK automaticky provedou v²echny pot°ebné

korekce a výsledný upravený snímek se zobrazí v okn¥ aplikace.



UTB ve Zlín¥, Fakulta aplikované informatiky
	

62

Obr. 7.6 Vytvo°ení nového
projektu

7.3.4 Ovládání plátna

Upravený snímek se vykreslí na kreslící plátno aplikace. Plátno je moºné p°ibliºovat,

posouvat a otá£et. Základní ovládací prvky jsou popsány v tabulce 7.1.

Tab. 7.1 Pohyb po plátn¥

Poºadovaná Akce Provedení
Posun plátna Stisk a sou£asné taºení pravého tl.

my²i

P°iblíºení a oddálení plátna Otá£ení kole£ka my²i
Rotace plátna Stisk a drºení klávesy Ctrl a sou-

£asn¥ stisk a taºení pravého tla-
£ítka my²i.

7.4 M¥°ení rozm¥r· a úhl·

Nástroj pro m¥°ení rozm¥r· se nachází v menu Tools→Measuring Tools→Ruler, p°í-

padn¥ je dostupný p°ímo z nástrojové li²ty. M¥°ení rozm¥ru pro�lu se provádí vºdy

mezi dv¥ma body na snímku. Stisknutím a drºením levého tla£ítka my²i se de�nuje

první bod. Taºením my²i se stále stisknutým levým tla£ítkem se ur£í druhý bod. Uvol-

n¥ním tla£ítka my²i se pozice m¥°ících bod· za�xuje a odpovídající rozm¥r se zobrazí v
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plovoucím okn¥. Následn¥ je moºné polohu m¥°ících bod· upravovat stiskem a taºením

levého tla£ítka my²i na po£áte£ním, nebo koncovém bod¥ ve tvaru ²ipky.

Obr. 7.7 M¥°ení rozm¥r·

M¥°ení úhl· probíhá podobným zp·sobem. Poloºkou v menu Tools→Measuring

Tools→Protractor se vybere nástroj úhlom¥r, p°ípadn¥ se zvolí p°ímo z nástrojové

li²ty. Úhlom¥r se ovládá stejn¥, jako pravítko pro m¥°ení rozm¥r·. Stiskem levého tla-

£ítka my²i a jejím taºením se de�nuje úse£ka ur£ující po£áte£ní úhel. Koncový úhel se

zobrazí automaticky v ose Y. Polohy obou úse£ek de�nujících sev°ený úhel je moºné

m¥nit stisknutím a taºením levého tla£ítka my²i na jejich koncích. Stejným zp·sobem je

moºné posunout celý úhlom¥r najednou p°i stisku a taºení levého tla£ítka my²i na jeho

st°edovém bod¥. Hodnota zm¥°eného úhlu se pr·b¥ºn¥ zobrazuje v plovoucím okn¥.

7.5 Srovnání s poºadovaným tvarem

Pro porovnání tvaru pro�lu s poºadovaným tvarem je moºné importovat výkres ve

formátu DXF. Podporované entity jsou POLYLINE, LINE, ARC a CIRCLE. Pokud

se ve výkresu vyskytují jiné elementy, je nutné jej nejprve p°evést pomocí externího

programu do jednodu²²í formy, která vyuºívá pouze uvedené elementy.

Otev°ít výkres je moºné pomocí volby v menu Final Shape→Load Shape, nebo p°ímo

z nástrojové li²ty, Po otev°ení se vykreslí na plátno ve stejném m¥°ítku, jako má pro�l
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Obr. 7.8 M¥°ení úhl·

na fotogra�i a je tak moºné opticky porovnat tvarovou shodnost. P°ípadn¥ lze zm¥°it

rozdíly pomocí nástroje Pravítko (Ruler).

Aby bylo moºné srovnání provést, musí se nejprve výkres posunout do stejné po-

lohy, jako má pro�l na fotogra�i. Výkres v tomto p°ípad¥ funguje jako samostatná

vrstva, kterou lze posunovat a otá£et stejným zp·sobem, jako samotné plátno. Stisk-

nutím pravého tla£ítka my²í a taºením se výkres posunuje, p°idrºením klávesy Ctrl p°i

posunování výkres rotuje. Pro p°epínání mezi editací plátna a výkresu slouºí p°epína£

v podob¥ dvou tla£ítek v nástrojové li²t¥.

7.6 Digitalizace pro�lu

Digitalizovat vyfocený pro�l je moºné pomocí ru£ního vyzna£ení jeho tvaru. K tomu

slouºí nástroj pro kreslení kubických Bézierovych k°ivek, které umoº¬ují velice jedno-

du²e popsat libovoln¥ sloºitý tvar. Kreslení Bézierovych k°ivek je dostupné v menu

Tools→Draw Polylines, p°ípadn¥ p°ímo z nástrojové li²ty.

Ve²keré kreslení a editace k°ivek se provádí pouze levým tla£ítkem my²i.
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Obr. 7.9 Srovnání fotogra�e pro�lu s poºadovaným tvarem

7.6.1 Kreslení rovných £ar

Kreslení rovné £áry se zahájí klepnutím levým tla£ítkem my²i do prostoru kreslícího

plátna. Tím se vytvo°í po£áte£ní bod £áry, jejíº druhý konec je p°ichycen ke kurzoru.

Op¥tovným klepnutím levým tl. my²i do volného místa na plátn¥ se p°ichycený bod

ukotví a ke kurzoru se p°ichytí nová £ára vedoucí od posledního p°idaného bodu.

Obr. 7.10 Krelsení rovných £ar

P°idávání bod· lze ukon£it n¥kolika zp·soby. Dvojklikem do volného místa na plátn¥,

kdy se na toto místo p°idá poslední bod, ze kterého jiº dal²í £ást £áry nepokra£uje.

Druhou moºností je stisk klávesy Esc, který odstraní bod p°ichycený ke kurzoru my²i a

na plátn¥ z·stane pouze poslední potvrzený bod. T°etí moºností je klepnutí na koncový
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bod jiné £áry, nebo k°ivky, £ímº se spojí v jednu. M·ºe se jednat i o po£áte£ní bod

aktuální k°ivky. Tím vznikne uzav°ený tvar.

7.6.2 Kreslení k°ivek

K°ivky se kreslí podobným zp·sobem, jako rovné £áry. První bod se p°idá klepnutím

levým tla£ítkem my²i do plátna. P°i p°idávání následujícího bodu se stiskne levé tla£ítko

my²i a sou£asným taºením kurzoru po plátn¥ se ur£í pozice °ídícího bodu Bézierovy

k°ivky. Ukon£ení kreslení se provádí stejným zp·sobem jako v p°ípad¥ rovných £ar

Obr. 7.11 Kreslení k°ivek

7.6.3 P°evod rovné £áry na k°ivku a naopak

Z rovné £áry je moºné jednoduchým zp·sobem vytvo°it k°ivku. Kurzor se umístí nad

poºadovaný segment k°ivky tak, aby byl zbarven ºlut¥. Následn¥ se stisknutím a drºe-

ním levého tla£ítka my²i za sou£asného taºení v poºadovaném sm¥ru vytvo°í z rovného

segmentu Bézierova k°ivka, spolu s odpovídajícími °ídícími body.

Obr. 7.12 Vytvo°ení k°ivky z rovné £áry

P°evést k°ivku zp¥t na rovnou £áru je moºné p°etaºením odpovídajících °ídících

bod· do po£áte£ního a koncového bodu k°ivky.

7.6.4 Výb¥r bod· pro editaci

Výb¥r v²ech nakreslených element· se provádí pomocí výb¥ru jejich bod·. Klepnu-

tím levým tla£ítkem my²i na poºadovaný bod se provede jeho výb¥r. Pro výb¥r více

bod· je t°eba drºet stisknutou klávesu Shift a postupným klepáním levým tla£ítkem

na jednotlivé body provést jejich výb¥r. Hromadný výb¥r bod· lze provést také pomocí
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výb¥rového obdélníku. Stisknutím levého tla£ítka my²i na volné plo²e kreslícího plátna

a sou£asným taºením ve zvoleném sm¥ru se vykreslí obdélník. Po op¥tovném uvoln¥ní

levého tla£ítka my²i se ozna£í v²echny body, které byly uvnit° tohoto obdélníku. Od-

zna£ení bod· se provede stisknutím klávesy Esc, nebo klepnutím levým tla£ítkem my²i

do volné plochy plátna.

7.6.5 P°esun a mazání bod·

Ozna£ené body je moºné p°esunout stisknutím levého tla£ítka my²i nad jedním z vybra-

ných bod· a následn¥ taºením my²i ur£it jeho novou polohu. Pokud je bod· vybráno

více, p°esunou se v²echny najednou. Ozna£ené body je moºné smazat stisknutím tla-

£ítka Delete. Smazat k°ivku je moºné pouze smazáním v²ech jejich bod·. Pokud na

plátn¥ z·stane k°ivka pouze s jedním bodem, automaticky zanikne.

7.6.6 Editace Bézierových k°ivek

Kaºdá Bézierova k°ivka má krom¥ svého po£áte£ního a koncového bodu také dva °í-

dící body, které de�nují její tvar. Zm¥nou polohy t¥chto bod· je moºné zm¥nit její

tvar. Dal²í moºností je uchytit stisknutím levého tla£ítka my²i p°ímo poºadovanou £ást

k°ivky a taºením my²i zm¥nit její tvar.

7.6.7 Roz²i°ování a spojování k°ivek

Do nakreslené k°ivky je moºné p°idat dal²í body dvojitým poklepáním na zvolené

místo na k°ivce. Pokud se jedná o rovnou £áru, p°idá se pouze bod. Pokud je zvolené

místo tvo°eno Bézierovou k°ivkou, rozd¥lí se daný segment na dv¥ men²í k°ivky, které

mají stejný tvar, jako p·vodní k°ivka. �ídící body nov¥ vzniklého spole£ného bodu

obou k°ivek se propojí a v p°ípad¥ editace jednoho z nich se zárove¬ zm¥ní poloha

druhého bodu v opa£ném sm¥ru. Tuto vazbu je moºné rozpojit dvojitým poklepáním

na spole£ný bod k°ivek.

Obr. 7.13 P°idání bodu na Bézierovu k°ivku

Roz²í°it neuzav°enou k°ivku je moºné dvojitým poklepáním levým tla£ítkem my²i

na jeden z jejich koncových bod·. Tím se naváºe nový bod na její konec a dále se

pokra£uje stejným zp·sobem, jako p°i vytvá°ení k°ivky.
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Spojovat a uzavírat k°ivky je moºné p°etáhnutím jednoho koncového bodu a jeho

upu²t¥ním na koncový bod jiné k°ivky, p°ípadn¥ jedné a té samé k°ivky, pokud má

vzniknout uzav°ený tvar.

7.7 Uloºení projektu a export dat

Celý projekt je moºné uloºit volbou v menu File→Save project As. Projekt se uloºí do

zvoleného umíst¥ní ve formátu XML. Dále je moºné z projektu exportovat pouze opra-

venou fotku pro�lu volbou File→Export Image. Na výber jsou formáty JPEG, BMP.

TIFF a PNG. V poslední °ad¥ je moºné uloºit vyzna£ený tvar pro�lu ve formátu DXF

volbou File→Export to DXF. V²echny nakreslené elementy se uloºí jako elementy typu

POLYLINE. P°i tomto p°evodu dojde k chyb¥, jelikoº Bézierovy k°ivky není moºné

zcela p°esn¥ p°evést na oblouky. Maximální tolerovaná chyba p°evodu se nastavuje v

menu Settings→Options.

7.8 Nastavení prost°edí

Nastavení programu se provádí v menu Settings→Options. Zde je moºné krom¥ nasta-

vení tolerancí p°i p°evodu k°ivek do oblouk· nastavovat také barvy a velikosti r·zných

gra�ckých prvk·. V²echna tato nastavení jsou uloºena v registrech Windows.
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8 M¥°ení dosahované p°esnosti

M¥°ení rozm¥r· pro�l· pomocí programu Pro�le Digitizer je závislé na spoust¥ pa-

rametr· a není tak moºné jednozna£n¥ de�novat dosahovanou p°esnost. V p°esnosti

hraje velkou roli kvalita po°ízené fotogra�e, p°edev²ím její ostrost. Dal²í d·leºitý para-

metr je rozli²ení fotogra�e a s tím související po£et pixel· na milimetr, který m·ºe být

odli²ný pro kaºdý po°ízený snímek. Dal²í významné parametry ovliv¬ující kvalitu jsou

vý²ka pro�lu, p°esnost °ezu, p°esnost korek£ní ²ablony, kvalita kalibrace fotoaparátu

a v poslední °ad¥ hraje roli také subjektivní sloºka, kdy je t°eba ur£it hranu pro�lu

vlastním úsudkem.

Dosahovanou p°esnost lze brát pouze jako orienta£ní hodnotu. V této kapitole jsou

výsledky m¥°ení n¥kolika testovacích a reálných pro�l· v porovnání s výsledky nam¥-

°enými pomocí digitálního posuvného m¥°idla. Referen£ní m¥°idlo má m¥°ící rozsah 0

� 200mm a udanou p°esnost 0,02mm.

Testovací snímky byly po°ízeny dv¥ma p°ístroji. Digitálním fotoaparátem Olym-

pus OMD EM10 a mobilním telefonem Huawei P9L, který zde �guruje jako zástupce

typického telefonu st°ední t°ídy, na který je aplikace Pro�le Digitizer cílena.

8.1 P°esný kovový válec - nízký

Materiál: Ocel.

Vý²ka: 19,8mm

Korek£ní ²ablona: A6

Tab. 8.1 Kovový válec - nízký, OMD EM10

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

Pr·m¥r 1 29,80 29,90 -0,1 -0,33

Pr·m¥r 2 29,84 29,90 -0,06 -0,20

Tab. 8.2 Kovový válec - nízký, Huawei P9L

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

Pr·m¥r 1 29,80 29,90 -0,1 -0,33

Pr·m¥r 2 29,96 29,90 0,06 0,20
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8.2 P°esný kovový válec - vysoký

Materiál: Ocel.

Vý²ka: 49,9mm

Korek£ní ²ablona: A6

Tab. 8.3 Kovový válec - vysoký, OMD EM10

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

Pr·m¥r 1 29,78 29,90 -0,12 -0,40

Pr·m¥r 2 29,73 29,90 -0,17 -0,57

Tab. 8.4 Kovový válec - vysoký, Huawei P9L

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

Pr·m¥r 1 29,72 29,90 -0,18 -0,33

Pr·m¥r 2 29,90 29,90 0,00 0,00
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8.3 Pro�l 1

Materiál: PVC.

Vý²ka: 23,7mm

Korek£ní ²ablona: A6

Obr. 8.1 Pro�l 1: M¥°ené rozm¥ry

Tab. 8.5 Pro�l 1, OMD EM10

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

A 50,57 50,85 -0,28 -0,55

B 45,13 44,96 0,17 0,38

C 3,52 3,52 0,00 0,00

Tab. 8.6 Pro�l 1, Huawei P9L

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

A 51,04 50,85 0,19 0,37

B 45,25 44,96 0,29 0,65

C 3,56 3,52 0,04 1,14
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8.4 Pro�l 2

Materiál: Hliník.

Vý²ka: 49,8mm

Korek£ní ²ablona: A5

Obr. 8.2 Pro�l 2: M¥°ené rozm¥ry

Tab. 8.7 Pro�l 2, OMD EM10

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

A 24,63 24,85 -0,22 -0,89

B 89,09 89,78 -0,69 -0,77

C 4,73 4,93 -0,20 -4,06

Tab. 8.8 Pro�l 2, Huawei P9L

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

A 24,73 24,85 -0,22 -0,48

B 89,43 89,78 -0,69 -0,39

C 4,88 4,93 -0,20 -1,01
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8.5 Pro�l 3

Materiál: PVC.

Vý²ka: 55,5mm

Korek£ní ²ablona: A4

Obr. 8.3 Pro�l 3: M¥°ené rozm¥ry

Tab. 8.9 Pro�l 3, OMD EM10

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

A 2,79 2,80 -0,01 -0,36

B 2,64 2,67 -0,03 -1,12

C 2,70 2,67 0,03 1,12

D 2,51 2,55 -0,04 -1,57

Tab. 8.10 Pro�l 3, Huawei P9L

Rozm¥r Nam¥°ený
rozm¥r [mm]

Skute£ný
rozm¥r [mm]

Absolutní
chyba [mm]

Relativní
chyba [%]

A 2,82 2,80 0,02 0,71

B 2,75 2,67 0,08 3,00

C 2,72 2,67 0,05 1,87

D 2,59 2,55 0,04 1,57
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ZÁV�R

Digitalizace a m¥°ení pro�l· bez pouºití speciálního hardwaru se z po£átku zdála jako

ne°e²itelný úkol, který nikdy nebude schopen dosáhnout poºadované p°esnosti. Oby-

£ejný digitální fotoaparát se zdál jako p°íli² nep°esný p°ístroj zatíºený spoustou obra-

zových vad. Postupem £asu se ale poda°ilo v²echny d·leºité defekty a zkreslení obrazu,

které pouºití fotoaparátu bránily pochopit a eliminovat je za pomoci speciálních algo-

ritm·. V²echny pokro£ilé úpravy obrazu umoºnila open source knihovna pro po£íta£ové

vid¥ní OpenCV, která pro tyto ú£ely poskytuje nep°eberné mnoºství algoritm·.

Postupn¥ se provedením nespo£tu pokus· a projitím mnoºství slepých uli£ek po-

da°ilo vytvo°it nástroj, který p°ekonal p·vodní o£ekávání. Vznikl m¥°ící systém, jehoº

jedinými hardwarovými poºadavky jsou digitální fotoaparát a korek£ní ²ablona, která

m·ºe být vytisknuta na tvrdém papíru. Náklady na po°ízení hardwaru jsou tak na-

prosto minimální, jelikoº dostate£n¥ kvalitní digitální fotoaparát je dnes b¥ºnou sou-

£ástí chytrých mobilních telefon·. V²echny pot°ebné korekce jsou provád¥ny £ist¥ soft-

warovou cestou pomocí aplikace, která dostala název Pro�le Digitizer.

Tato aplikace umoº¬uje m¥°it ve²keré rozm¥ry a úhly pro�lu, dokáºe porovnat sku-

te£ný tvar s poºadovaným tvarem a pomocí zabudovaného vektorového editoru p°evést

tvar pro�lu do formátu DXF, díky kterému je moºné se získanými daty dále pracovat

v nejr·zn¥j²ích CAD programech. Aplikace Pro�le Digitizer m·ºe slouºit i jako nástroj

pro archivaci jednotlivých vytla£ovacích pokus·, kdy dokáºe nahradit nepraktické skla-

dování vzork· a zárove¬ umoº¬uje jejich posílání elektronickou po²tou.

Postup m¥°ení se m·ºe na první pohled zdát komplikovaný, jelikoº je t°eba zajis-

tit, aby byla korek£ní ²ablona rovná, coº v p°ípad¥ papíru vyºaduje hustotu alespo¬

250g/m2. Dále je t°eba u°íznout plátek pro�lu rovn¥ a zachovat ostré hrany (stejný

poºadavek bývá i u profesionálních skener·). V poslední °ad¥ je t°eba po°ídit ostrou

fotogra�i. Neostré snímky jsou problémem zvlá²t¥ u levných fotoaparát· p°i zhor²e-

ných sv¥telných podmínkách. V²echny tyto problémy jsou ale velice jednodu²e °e²itelné

se zanedbatelnými �nan£ními náklady oproti po°ízení profesionálního p°ístroje.

Pouºití nástroje Pro�le Digitizer se p·vodn¥ vztahovalo pouze na vytla£ované pro�ly

z plastu. Jeho pouºití je ale mnohem ²ir²í. Nic nebrání m¥°ení pro�l· z jiných materiál·,

nap°íklad z hliníku, nebo z gumy. Krom¥ pro�l· jej lze pouºít také na v²echny ostatní

p°edm¥ty obdobného charakteru, jako jsou r·zné trubi£ky, t¥sn¥ní, vy°ezávané výrobky

a dal²í.

Dosahovaná p°esnost m¥°ení je závislá na spoust¥ parametr· a nelze ji jednozna£n¥

ur£it. Ovlivn¥na je rovnosti korek£ní ²ablony a p°esnosti jejího zm¥°ení, rozli²ením po-

uºitého fotoaparátu, ostrosti fotogra�e a vlastním úsudkem. Hlavním rozdílem oproti
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mechanickým m¥°ícím nástroj·m je chyba procentuáln¥ vztaºená k délce. Chyba na-

m¥°ená na testovacích pro�lech byla v pr·m¥ru okolo 1%, coº je dosta£ující pro v¥t²inu

p°edpokládaných pouºití. P°i m¥°ení v¥t²ích rozm¥r· se procentuální chyba projevuje

ve v¥t²í mí°e a m·ºe se tak dostat i mimo tolerovanou mez. Typickým poºadavkem

je ale m¥°ení tlou²t¥k st¥n, kde naopak tato chyba m¥°enou hodnotu tém¥° neovlivní

a dosahovaná p°esnost je v tomto p°ípad¥ tém¥° srovnatelná s digitálním posuvným

m¥°idlem.

Dal²í d·leºitý parametr, který ovliv¬uje p°esnost m¥°ení je vý²ka u°ezaného plátku

pro�lu. Vý²ka hraje roli hned ze dvou d·vod·. Prvním z nich je samotný algoritmus,

který se stará o opravu perspektivy ve správné rovin¥. �ím vý²e je t°eba rovinu ²ablony

posunout relativn¥ k rozm¥r·m ²ablony, tím vznikne v¥t²í chyba. Druhým d·vodem je

hloubka ostrosti, která se projevuje p°edev²ím u fotoaparát· v mobilních telefonech,

kde není moºné nastavit hodnotu clony. Pokud je pro�l p°íli² vysoký, tak není moºné p°i

focení z krátké vzdálenosti zachytit ost°e jak ²ablonu, tak pro�l. Pro v²echny p°ípady

se osv¥d£ila vý²ka pro�lu okolo 3cm. Je to rozm¥r, který se dá pom¥rn¥ snadno u°ezat

u libovoln¥ sloºitého pro�lu a nep°esnost zp·sobená vý²kovou korekcí je v únosných

mezích. Rovn¥º hloubka ostrosti u takto nízkého pro�lu v¥t²inou není problémem.
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